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INTRODUCTION TO THE DATABASE AGENT

The Sun StorageTek Business Analytics Database Agent collects information about
database servers, such as database server type, version, allocated spaces, and
input/output operation (statistics). The Database Agent currently supports four major
commercial database servers: MS SQL server, Oracle, DB2, and Sybase.

Note: With the acquisition of StorageTek, Sun Microsystems has re-branded and re-
named Global Storage Manager (GSM) as Sun StorageTek Analytics, a member of the
Enterprise Storage Manager portfolio of software solutions. The functionality of Business
Analytics is identical to GSM, only the name has changed.

The Database Agent requires that appropriate client software be installed on the system
that runs the Database Agent. Be sure to install the client software and verify
connectivity to the database before you proceed to install the Database Agent. Refer to
the Sun StorageTek Business Analytics Support Matrix to obtain the latest information
on supported databases and their support prerequisites.

To upgrade the Database Agent, uninstall the previously installed Database Agent before
you install the Database Agent supplied with the latest Sun StorageTek Business
Analytics software. The decision to upgrade an existing Database Agent to that in the
latest Sun StorageTek Business Analytics software may be performed because:

e The Sun StorageTek Business Analytics Release Notes indicate a problem has been
fixed or a new feature added.
e The upgrade is recommended by your Sun representative.

AUTOMATIC AND STATIC AGENT REGISTRATION

Automatic agent registration is a configuration option for agent data collection. In the
storability.ini file, automatic agent registration is configured as follows:

¢ Local Manager - Specify the IP address or host name of the Local Manager to be
contacted to activate agent registration.

¢ Local Manager Registration Port - Specifies the TCP port number used by the
Local Manager for agent auto registration. The default port number is 17146.

o Enable Auto Registration - Turns agent auto registration on (default) or off.

To register the Database Agent statically, proceed as follows:
e Enter false in the Enable Auto Registration field.
e Modify the Routing Agent static agent configuration to include an entry (port
number|<agent IP address/name>)
e Restart the Routing Agent
e Restart the companion Central Manager agents
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DATABASE AGENT OBJECTS

Table 1 lists the objects that the Database Agent publishes regardless of the SQL type or

installed server platform.

Table

Columns

alerts-3-0

sourceip, priority, alert_id, progname, alert, time,
firsttime, refreshedtime, intl, textl, text2.

agent_version-2_0

ip_address, agent_name, version, compile_time,
managed_entities, tz_name, tz, timestamp

gsa_cache_control-2_1

ip_address, port, table_name, cache_age,
last_update_request_length,
update_request_pending, group_name,
group_master, timestamp

gsa_ini_control-2_0

ip_address, port, domain, parameter, value, status,
timestamp

gsa_parm_info

ip_address, port, object, parm_name,
value_syntax, description, example

gsa_dba_application_storage_unit-
2_1

db_server_ip, instance_name, port_no, db_name,
unit_name, owner, measure_type, measure,
timestamp

gsa_dba_database_server-2_1

db_server_ip, port_no, database_type, version,
instance_name, timestamp

gsa_dba_specific_data-2_1

db_server_ip, instance_name, port_no, db_name,
map_type, item1l, item2, timestamp

gsa_dba_db_stats-2_1

db_server_ip, instance_name, port_no, db_name,
tables_count, views_count, indexes_count,
users_count, active_users_count, sessions_count,
timestamp

gsa_dba_io_indicators-2_1

db_server_ip, instance_name, port_no, unit_type,
unit_name, reads, writes, timestamp

gsa_dba_physical_storage_unit-
2.1

db_server_ip, instance_name, port_no, db_name,
unit_type, unit_name, physical_type,
physical_name, used_space, total_space,
auto_increment, auto_incr_max_limit, timestamp

gsa_dba_served_databases-2_1

db_server_ip, instance_name, port_no, db_name,
owner, timestamp

Table 1 - Database Agent Objects
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DATABASE AGENTS MATRIX

Item

Description

Support
Prerequisites

Software and hardware
agent support
requirements

Refer to the Sun StorageTek Business Analytics Support Matrix
that is located on the Documentation CD to obtain the latest agent
support requirements.

Verify Database Client
Interface Installed and
Tested

Access method the Database Agent uses to collect data.

e Oracle database server plug-in uses OCI libraries

e Sybase database server plug-in uses Sybase OpenClient CT
library

e MS SQL Server database server plug-in uses DB Library for C

e DB2 database server plug-in uses DB2 CLI Library, System
Monitor APIs and Admin APIs.

Verify logical name, IP
address, and port
number of the
database server

Obtain information from the Database Administrator (DBA).

Verify user created with
required “Select”
permissions to the
required tables

Provides agent “Select” access to the database tables; Sun
StorageTek Business Analytics provides Database User Creation
scripts that DBA may modify to suit their environment.

Agent Installation

Windows e Windows Local Manager Installation CD (InstallShield)
e Windows administrator privileges
Solaris e Unix Local Manager Installation CD (package installation)
root user privileges
GSMbase, GSMImutil, GSMdb, GSMsybase, GSMdb2, or
GSMoracle
AIX/HP-UX e UNIX Agents Installation CD (Tar Archive installation)

e root user privileges

DB2 Database
Reporting

Because of a Database Agent CLI/API restriction, the Database
Agent for IBM DB2 does not currently report on used storage for
the following storage elements of the DB2 database server:

e Container (file, directory)
e System Managed Storage (SMS)
e Database Managed Storage (DMS)

As a result, the Database Configuration/Capacity report in the
Management Console shows the utilization for System Managed
Storage, Database Managed Storage, and SMS tablespaces as
100% utilized. However, the Database Managed Storage
tablespace utilization is correctly reported in this Management
Console report.

Database Agent Installation Guide
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Configuration
Parameters

Description

User Login

The user name the Database Agent should use to connect to the
database server.

User Password

User password for that user.

IP Address

The IP address of the host on which the database server is
running.

Port Number

The port number at which the database server (or database
instance for DB2) is listening for client connections.

Database Type

MS-SQL, Oracle, Sybase, DB2

Logical Name

Name of the database server; is the database instance name for
DB2.

Local Manager

Network resolvable host name or IP address that identifies the
Local Manager with which the Database Agent is to register if auto
registration is enabled.

Local Manager Port

Local Manager’s TCP port humber used for agent auto registration;
default port number is 17146.

Enable Auto
Registration

Auto registration is enabled (true) by default; may disable auto
registration by setting this configuration parameter to false.

Table 2- Database Agent Matrix

GENERAL CONFIGURATION GUIDELINES

The Database Agent can be installed on Windows or Solaris and collect data from other
database server platforms using the database’s client interface. See the Sun StorageTek
Business Analytics Support Matrix located on the Documentation CD to obtain the latest
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information on supported hardware platforms and databases as well as their support
prerequisites.

Important Note: While you configure the Database Agent, you are prompted to enter
the logical name, IP address, and port number of the database server. However, the
Database Agent only uses the logical name to connect to the database server(s). The IP
address and port fields are used for reporting purposes only.

Therefore, in order for the Database Agent to function, it must rely on a working
logical name. In SQL, a working logical name means either:

e An entry in the registry key under:
HKLM\Software\Microsoft\MSSQLSERVER\client\connectto or:
e A name or IP address that can be resolved by the SQL client osql

In Sybase or Oracle, the logical name must be manually configured through the
respective client tools.

The installation of the Database Agent creates a directory structure (e.g., C:\Program
Files\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent User Creation
Scripts\<subdirectory>) where the scripts are located to help your Database
Administrator set up the necessary access permissions for the Database Agent to
successfully connect to the database and collect data. On Windows, the
<sub_directories> are \db2, \mssql, oracle, and sybase. In addition, the
Readme_dbAgent.txt file describes general usage information and locations (all
platforms) of the user creation scripts.

On an IBM AIX server, you must manually register the Database Agent to the Local
Manager. This is performed by either adding the entries for the GSM_LM_HOST in the
storability.ini file for the agent or by adding the SUB_AGENT entry in the Local Manager
Routing Agent’s configuration settings.

IBM DB2 AGENT

The following sections describe how you install, configure, and verify the Database Agent
to report on IBM DB2 databases.

DB2 RUN TIME CLIENT SOFTWARE PREREQUISITE

The DB2 Run-Time client software must be installed on the server where the Storability
Database Agent is to be installed. If the DB2 Run Time client is installed the following
should exist:

¢ Program Group - The following program group is generally created by the DB2
Run-Time Client installation:

5 Evoe: d EL| client Configuration Assistant

[¥% Cammand Center

pe2 Command Line Processor

Caommand \indow

i

Figure 1 - DB2 Run-Time Program Group
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e Registry Key Entries - The following registry keys are created by the DB2 Run-
Time Client installation:

=10lx|

Registry  Edit  Wiew Favorites Help

E‘D 1M ;! Mame | Tvpe | Data
HCI DB2 E‘ﬂ(DeFault) REG_5Z {walue not set)
{0 Components [aB]Description REG.SZ  DB2 Rur-Time Client
-3 pata Warehouse Cente | [ab) 1o o) pate REG_SZ  5-20-2003
&3 bB2 Run-Time Client [aB]Last Modified Date REG_SZ  5-20-2003
a Soeonents [ab]modification REG.SZ 3
Currentyersion EszRebase REG 57 1
8 f;:;u'Z;;PROFILE Service Level REG_SZ WRZ21254
- PROFILES @Title REG_SZ  DB2 Run-Time Client
"2 Urinstal [aB]version REG SZ 7
(1 TrackPoint

-2 Installshield
-2 INTEL

B JavaSoft
B[] KasperskylLab
B+ Kantiki

D Lirnehire: -
4] | I (O |

||My ComputeriHKEY_LOCAL_MACHINE\SOFTWARELVIBMIDEZ\DEZ Run-Time Client\CurrentVersion

ail=

Figure 2 - DB2 Client Registry Entries

DB2 SERVICE NAME PREREQUISITE

This section describes how you verify that a configuration entry exists for the database
you wish to connect to.

1. Use the DB2 Client Configuration Assistant from the IBM DB2 program folder to view
a listing of the databases.

E Client Configuration Assistant

Available DBZ D atabazes

x

[ atabaze alias | ODBEC Mame | Comment | Add...
8 STORDET STORDET D atabase with SMS and DMS

Delete

Properties...

Bind...

il

Test

Fazzword...

— Databaze Properties

Target databaze: STORDE1 Protocol;  TCFR/P
Spaten: aix-\:’iper Host name: aix_viper

{ient Settings | Import... | Erpart... | Close | Helpl

Figure 3 - DB2 Client Configuration Assistant

Note: If a DB2 database entry does not exist for the database, you must create it,
as described below in Steps 2 to 12.

2. Start the DB2 Run-Time Client Configuration Assistant from the IBM DB2 program

folder.
3. Click on the Add button to add a new database definition.
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B client Configuration Assistant

Available DBE2 Databazes

[atabaze alias | ODBLC Mame | Comment |

Eroperties..,

il

FPaszword.,, |

Bind.

Tiest

- Database Properties

Import... | Export... |

 Client Sefings.., |

Cloze | Helpl

Figure 4 - IBM DB2 Client Configuration Assistant

4. A new window will appear prompting you for how you want to set up the connection.

5.
6.

8.
9.

Select Search the network and click Next.
If there is no entry for the server under Known Systems, click Add System.
Select TCP/IP for the protocol and enter the hostname or IP Address of the
server where the database is running and then click OK.

| iAdd Database Wizard N
1. Souss 2 Databasename | 3 Alias| 4 ODEC
Step 2: Select a database fram the list.

gateway connections, specify the connection route.

To search for databases, expand the tree below. Then select the database that pou want from the list. For

@] Known Systems
- Other Systems [Search the network)

[ielete Sustem

Hefresh Spstem

E‘_H Add System _ ll
Select the protocol pou want to uze to find the server.
Protocol ITCP.-’IF' LI
L [ TCRAP
Target datab. I
A e Host name [10255.252.90
Comment
Mexts> I Cancel Help |

To refresh the database list for & system, click the system name and then click Refresh System or double-click on
the spstem name. I the spstem that pou want to search is not listed, click Add System to update the list.

Aidd System |

T
Il
ELED
FEinish | Cancel Helpl

Figure 5 - Add System Using the Add Database Wizard

Database Agent Installation Guide

Expand the option for the system where the database you want to connect to is
running. The tree should expand and display any instances of both locally and
remotely installed databases.
Select the database you want to connect to and click Next.
Create an alias for database if desired and click Next.
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10.0On the ODBC screen, ensure that the Register this database for ODBC is checked,
and that the “As a system data source” option is selected and click Finish.

I : Add Database Wizard 1 x|
1 Suurcei 2. Database name] 3 Aliss 4 ODBC i
Last Step: Reqister thiz databaze as an ODEC data source.

The ODBC [Dpen Database Connectlivity] interface allows different pragrams to access relational databases.
Select Sustem data source if you want any user to be able to access thiz data source. Select Lzer data source if
you are the only uger that will access this data source. Select File data source if you want to create a fils that
containg data source information.  If this iz a TCPAP connection, the file data source created will be shareabls
among machines. For other types of connections, the file data source created will be unshareable, mearing that it
will only work on this machine.  To optimize the data source for a particular application, select that application fram
the list pravided below

[V Begister this database for ODBC
{* Az a system data source
€ Az auser data source

" Az afile data source

Optirize far application
I<Select> _'j

Cancel ‘—H—E_I_pd
Figure 6 - Add Database Wizard ODBC Configuration

<<Back !

11. A message should appear indicating that the connection was successfully configured,
and prompt you to test the connection. Click the Test Connection button to test
the newly defined connection.

12. Enter the User ID and Password to test the connection with and click OK. A
message box will appear that indicates whether or not the connection test was
successful.

DB2 NODE NAME PREREQUISITE
You should now be able to use the Command Line Processor to list the node directory on
the database. The node name will be required later for configuring the Database Agent.

1. Launch the DB2 Command Line Processor from the DB2 Program folder.
2. Execute the LIST NODE Directory command to list the node directory on the
database, as shown in the following figure.

2 CLP - DB2CLP.BAT DB2.EXE

the first few keywords of a database manager command. For example:

? CATALOG DATABASE for help on the CATALOG DATABASE command

? CATALOG for help on all of the CATALOG commands.
To exit db2 interactive mode. type QUIT at the command plompt Outside
interactive mode, all commands must he prefixed with ‘dh2’

To list the current command option settings. type LIST COHHHND OPTIONS .
For more detailed help,. refer to the Online Reference Manual.

dh2 => LIST NODE DIRECTORY

Node Directory

Mumber of entries in the dirvectory = 1

lNode 1 entry:

ALXZHUIBL
TCPIP

aix_viper

58888

Mode name
Comment
Protocol
Hostname
Service name

2

Figure 7 - List Node Directory
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INSTALLING THE DATABASE AGENT FOR DB2 - WINDOWS

This section describes how to install and configure the Database Agent on a Windows

platform.

1. Insert the Windows Local Manager CD into the CD-ROM drive.

2. Click Next on the Welcome menu to continue the installation.

3. Click Yes to accept the terms of the software license agreement.

4. Click Next.

5. Review/modify the User Name and Company Name and click Next.

6. Click Next to accept the default destination folder.

7. A screen listing the components available for installation will then appear. Check the
Database Agent box to install the database agent.

8. A screen will appear prompting for the type of databases to install support for.
Select DB2 and any other databases the agent will be configured to communicate
with.

9. If launched, close the Configuration Tool. You can run the Configuration Tool from

the Storability Program Folder after you have created the Database User, which is a
required configuration parameter.

10. Click OK to view the Readme_dbAgent.txt file.

CREATING THE DATABASE AGENT OPERATING SYSTEM ACCOUNT

The Database Agent requires that you create an account for it to use with SELECT
permissions to specific tables. To avoid using the system account, it is recommended
that you create a dedicated account with only the required permissions.

Additionally, DB2 requires the user of an operating system account with group access to
the database files.

The required permissions are listed in the following tables.

Permission Object Name Object Database Name
(<schema>.<table/view>) type

Select SYSIBM.SYSCOLUMNS tsayljffm Every database

Select SYSIBM.SYSVERSIONS f’aybslzem Every database

Select SYSIBM.SYSTABLES tsayrj‘;em Every database

Select SYSCAT.INDEXES \Sli‘;svsem Every database

Select SYSCAT.TABLES \S/iy‘/:‘,/'\clem Every database
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Permission Object Name Object Database Name
(<schema>.<table/view>) type

Select SYSCAT.VIEWS \S/.iyesvtem Every database

Select SYSCAT.COLAUTH Sif\’/sem Every database

Select SYSCAT.DBAUTH SYStem | Every database

Select SYSCAT.INDEXAUTH siyesvsem Every database

Select SYSCAT.PACKAGEAUTH \% Svf,em Every database

Select SYSCAT.PASSTHRUAUTH \% Svf/em Every database

Select SYSCAT.SCHEMAAUTH sigf/em Every database

Select SYSCAT.TABAUTH \% S\At,em Every database

Select SYSCAT.TBSPACEAUTH agsem Every database

API Type of API | Authentication required

sqglegins Admin API None

sglenops Admin API None

Sglengne Admin API None

sglencls Admin API None

sgledgne Admin API None

sqlbmtsqg Admin API One of the following: Sysadm, sysctrl, sysmaint,
dbadm, load

sqlbtcq Admin API One of the following: Sysadm, sysctrl, sysmaint,
dbadm

sglefmem Admin API None

sglmonsz Monitor API One of the following: Sysadm, sysctrl, sysmaint

sglmonss Monitor API One of the following: Sysadm, sysctrl, sysmaint

sqgledosd Admin API None

sqledcls Admin API None

sqlbgtss Admin API One of the following: Sysadm, sysctrl, sysmaint,
dbadm, load

sgleatin Admin API None

sgledtin Admin API None

API Type of API | Authentication required

sqlaintp Admin API None

Note: If the user account does not have membership in the group that owns the
database files, the agent will not have sufficient permission to report the following

tables:
e gsa_dba_db_specific_data
e gsa_dba_db_stats
e sa_dba_io_indicators
e gsa_dba_logical_storage_unit
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For example, you may create an account, gsmdb, for use with the agent. To do so, you
perform the following steps:

e Create an account on the server, gsmdb.
e Determine the group ownership permissions for DB2, and then add the user
account gsmdb to that group.

CREATING THE DATABASE AGENT ACCOUNT AND PERMISSIONS

Once the operating system account has been created and added to the appropriate
group, you create a database account and permissions. The Database Agent installation
will install a set of user creation scripts located at:

\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent
User Creation Scripts\<sub directory>

that can help the administrator to fulfill this requirement. On Windows, the following
subdirectories are created: db2, mssql, oracle, and sybase.

1. Change directory into the db2 subdirectory of "dbAgent User Creation Scripts”.

2. View the readme_windows.txt file for notes about the dbagent_db2_create_user.bat
script.

3. Execute the script dbagent_db2_create_user.bat using the following syntax:

dbagent db2 create user.bat NODE DBAGENT USER DBAGENT PWD ADMIN
ADMIN PWD

where only ADMIN_PWD may be empty.

Example:

dbagent db2 create user.bat AIX#VIOl gsmdb <password> <db_ admin>
<admin_ passwd>

CONFIGURING THE DATABASE AGENT FOR DB2 - WINDOWS

Launch the Configuration Tool from the Storability Program Folder.

Select File ->Edit -> Smart Agent Configuration.

Select the Database Agent tab

Click the Add button to add another entry to the current configuration.

From the Add dialog box that appears, select DB2 as the type of database to

connect to.

Enter the name of the database user account, which has the required access

permissions.

7. Enter the port number for the DB2 database.

8. Enter the node name of the DB2 database in the Logical Name field. This should
match the node name returned by the LIST NODE DIRECTORY command.

9. Enter the IP Address of the database server.

10. Enter the password for the database user account.

11. Click the Submit button to add the database server to the configuration.

12.1In the Local Manager field, enter the IP address or host nhame of the Local Manager

that the Database Agent will contact for agent auto registration.

uhwh=

o
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13.In the Local Manager Port field, specify the TCP port number the Local Manager
uses for agent auto registration. The default port number is 17146.
14. Click Show Advanced Settings and review/modify the following parameters:

15.

16.
17.

Enable Auto Registration - Accept that auto registration is enabled (true) or
set this parameter to false to disable auto registration.

DBA_NUM_ASUS - Number of application units per database in the
gsa_dba_application_storage_unit table; default value is five (5).

Connection Timeout SQL Server Only - Only used for MS SQL Server.
QueryTimeout SQL Server Only - Is only used for MS SQL Server.

DBA_TEST_MODE - Sets the Database Agent’s operational mode where zero
(0) turns off test mode and one (1) enables it.

DBA_CACHE_EXPIRY_PERIOD - How long (in seconds) the Database Agent
should keep reporting cached database server information after it receives errors
while retrieving information from a certain database server. The default value is
86400 seconds.

With “Save Configuration Settings” turned on (check mark), select File->Save
and confirm changes to the storability.ini file.

Select File->Exit to close the Configuration Tool.

Use the Windows Services panel to start the agent before you verify agent
functionality.

Note: The Database Agent uses a common configuration file regardless of the database.
When using the Database Agent with DB2, the IP Address and Port fields are not used to
make the connection. That is, only the account information and Node Name (which is
entered in the Logical Name field) are used.

VERIFYING THE DATABASE AGENT ACCESS PERMISISONS FOR DB2
Check the Message.log for error information. Some notes follow.

Page 15

When the agent starts, the first message it will log is a startup banner. It shows
the agent has started and its software version.

If the agent has been configured properly and can access and authenticate itself
to the database, an informational message similar to the following will be
generated:

06/11/2003 16:02:51PM|INFO|0|Connection test (DB2,AIX#VIO1l,dbact)
:Passed|dbAgent.exe|CDblibHelper.cc|258

If the username or password supplied to the agent is incorrect, it will generate
the following error when trying to connect to the database:

06/12/2003 10:18:13AM|INFO|0|Connection test

(DB2,AIX#VI01l,dbact) :Failed: CDB2APIException:SQLCABC = 136, SQLCODE
= -1403, SQLERRMC = , SQLERRP = SQLEXAUS, SQLWARN = , SQLSTATE =
08004 SQL1403N The username and/or password supplied is incorrect.
SQLSTATE=08004 |dbAgent.exe|CDblibHelper.cc|258

If the database account’s password is valid but has expired, the agent will not be
able to login to the database and will generate the following error messages:
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06/11/2003 15:16:39PM|INFO|0|Connection test

(DB2,AIX#VI01l,dbact) :Failed: CDB2APIException:SQLCABC = 136, SQLCODE
= -1404, SQLERRMC = , SQLERRP = SQLEXAUS, SQLWARN = ,
SQLSTATE = 08004 SQL1404N Password expired. SQLSTATE=08004

| dbAgent.exe|CDblibHelper.cc|258

Note: If you receive this error message, you will need to change or reset the
account’s password using the DB2 Command Line Processor. When
connecting to the database, use the database alias, not the node name. For
example:

db2=> connect to <dbalias> USER <user-id> CHANGE PASSWORD
i.e.

db2 => connect to STORDB1 USER dbact CHANGE PASSWORD
Enter current password for dbact:

Enter new password for dbact:

Confirm new password for dbact:

o If the system account has not been created or if an invalid user name is used,
the agent will not be able to login to the database and will generate the following
error messages:

06/11/2003 14:28:57PM|INFO|0|Connection test
(DB2,AIX#VI01l,gsmdbuser) :Failed: CDB2APIException:SQLCABC = 136,
SQLCODE = -1046, SQLERRMC = , SQLERRP = SQLEXAUS, SQLWARN = SQLSTATE
= 28000 SQL1046N The authorization ID is not wvalid. SQLSTATE=28000
| dbAgent.exe|CDblibHelper.cc|258

e If the system account is not a member of the group which owns the database
files on the server, the agent will not be able to collect and report some
information and will generate the following error messages:

06/12/2003 11:22:54AM|ERROR |0 |Exception while serving GSM table:
gsa_dba db specific data: Connection (DB2,AIX#VIOl,dbact):
D:\ga\storability\dev\src\dbAgent\CDB2DBServerInfo.cc:1183:CDB2APIExX
ception:SQLCABC = 136, SQLCODE = -1092, SQLERRMC = DBACT ¥,
SQLERRP = SQLEXCMN, SQLWARN = , SQLSTATE = SQL1092N "DBACT" does
not have the authority to perform the requested command.

| dbAgent.exe|CDblibHelper.cc|562

When this occurs, the agent will not publish any information for the following
tables:

e gsa_dba_db_specific_data

e gsa_dba_db_stats

e sa_dba_io_indicators

e gsa_dba_logical_storage_unit
e gsa_dba_physical_storage_unit

DATABASE AGENT FOR MICROSOFT SQL SERVER

The following sections describe how you install, configure, and verify the Database Agent
for MS SQL Server databases.
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MiCROSOFT DATA ACCESS COMPONENTS (CLIENT TOOLS) PREREQUISITE
The Microsoft Data Access Components (Client Tools) software must be installed on the
server where the Storability Database Agent is to be installed. This is typically installed
on the database server with SQL server. However, these components can be installed

individually on a non-database server.

If the Microsoft Data Access Components (Client Tools) is installed the following should

exist:
Program Group - The following program group is generally created by the Microsoft

Data Access Components (Client Tools) installation:

000 Server

Access Components (Client Tools) installation:

E Prograrns

E Microsoft S0L Server

L4 E? Books Online
Zb Client Metwork Uity =
rﬁ] Configure SQL ¥ML Support in 115
Bﬁj Enterprise Manager

% Import and Export Data

@ Profiler

% Query Analyzer

Figure 8 - Microsoft Data Access Components Program Group

ntwdblib.dll - The ntwdblib.dll library should also exist in the
%Windir%\system32 directory. This library must exist in the default path so the
database agent can use it to communicate to the database.

Registry Entries - The following registry keys are created by the Microsoft Data

£ Registry Editor
Registry Edit  Wiew Fawvoribes Help

L] MediaPlayer
ED Microsoft QL Server
: {1 &.00.000
=+ 80
{1 Registration
Elf:l Replication
=37 Toals
Er.:l ClientSetup
S f Ut ersion
(] Help
4 .:I Service Manager
-1 SQLEW
-] Tracking

H i:l Component Set
i

Tvpe | Data

REG_SZ (value not set)
REG_52 5.00.194
REG_D... 0x00000409 (1033

ODBC data source name - Verify that an ODBC data source name is configured for
the database you wish to connect to.

a.

Figure 9 - Microsoft Data Access Components Registry Entries

wish to connect to.
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From the Control Panel, select Administrative Tools -> Data Sources (ODBC).
b. Select the System DSN tab and verify that an entry exists for the database you
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€1 0DBC Data Source Administrator i x|
Usger DSW  Spstem DSH |File DSH | Driversl Tracingl Connection F'UUIingI Ahbout I

Swustern Diata Sources:

| Diiver | «| Add...
SOL Server
CR DB2 Bemove
CRORSVIE CR Oraclel v3.6

i

CRSS SOL Server -Qonfigure...
CRSYE CR Sybasze Syatem 10

CR=MLVEE CR =ML w3 B

db SOL Server

dbzyb3 Sybaze ASE DDBC Driver

odbesyb2 Sybaze A5E DDBL Driver

STORDE Bt DEZ2 ODBC DRIVER

widey SOL Server ;j

An ODBC System data source stores information about how to connect ta
the indicated data provider. A Spstem data source iz wisible to all users
aon thiz machine, including MT services,

QK l Cancel | Spply | Help |

Figure 10 - ODBC Data Source Administrator

c. Test the connection by selecting the data source name (DSN) and click
Configure.

d. Click Finish and from the window that appears click the Test Data Source ...
button. If the DSN is set up properly you should see a successful test message
similar to the following.

A new DDBC data source will be created with the follawing ~ Test Results
configuration: . 2 : 2
Wiorosoft STL 55wl ODBC Driver Viersion 03,81 9031 _:J Microzaft SOL Server QDBC Dnver Yerzion 03.81.9031 _A_I ;

FiAt ource bl amesatisnis Running connectiviy tesks. L]

D ata Source Description: atlantis

Server 127.0.0.1

[atabase: assurent

Language: [Default)

Translate Character D ats: Yes

t°9 Lang Rurnning Queries: No TESTS COMPLETED SUCCESSFULLY!
og Diiver Statistics: Mo

Use Integrated Securty; Mo

Usze Regional Settings: No

Prepared Staternents Option: Drop temparary procedures on

disconnect

Usze Failover Server: Mo

Use ANS| Quated |dentifiers: *es

Use ANSI Mull, Paddings and Warnings: Yes

Data Encrpption: Mo

Attempting connection
Connection established
Werifying option settings
Dizconnecting from server

=
Test Data Source... | oK | Cancell

Figure 11 - SQL Server ODBC Data Source Test

Note: If an ODBC data source name does not exist for the database, it must first be
created. The following steps (e-k) provide instructions to create a data source name.

e. From the Control Panel, select Administrative Tools -> Data Source (ODBC).
f. Select the System DSN tab and click the Add button to create a new data
source name (DSN).
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g. Enter the name and description for the data source, then enter the IP Address

or hostname of the server on which the database exists and click Next.

h. Select With SQL Server authentication ... for the authentication type, and
click the Client Configuration button.

i. Select TCP/IP from the list of network libraries and enter the IP Address or
hostname for the alias and server name. If the database is running on a port
other than the default of 1433, modify the port number and then click OK.

j. Click Finish to complete the configuration and from the confirmation window that

appears click Test Data Source to test the configuration.
k. Test the DSN with the account created for the Database Agent, as shown below.

osgl -Ugsm _db

Password:

1> use master

2> go

1> select * from sysdatabases
2> go

INSTALLING THE DATABASE AGENT FOR MSSQL

This section describes how to install and configure the Database Agent on a Windows

platform.

1. Insert the Sun StorageTek Business Analytics Windows Local Manager CD into the
CD-ROM drive.

2. Click Next on the Welcome menu to continue the installation.

3. Click Yes to accept the terms of the software license agreement.

4. Click Next.

5. Review/modify the User Name and Company Name and click Next.

6. Click Next to accept the default destination folder.

7. A screen listing the components available for installation will then appear. Check the

Database Agent box to install the database agent.
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InstallShield Wizard x|
Sun StorageTek™ Business Analytics
SETUP

Select features to be installed and click Mext.
Y'ou can chooze not o inzstall thiz application by clicking on Cancel to exit Setup.
| Local k anager | D atabaze [~ HPP Agent
[™ Routing Agent [ Databaze fgent [ Celerra Agert
™ Proxy Agent | Auray [~ SHIS Arap Agent
| Hoszt [ Clariion Agent -

rc P | Fabiic:

ompag Agen

I Hast Agent [~ Fabric &gent
™ SRM Agent [T Compag EWé Agent
[T Remote Host Agent I EMC Agent | Tape Library

[T ESS Agent [T STE Libramy fgent
| Backup [ HDS [DAMP) Agert [ 1Bt 3494 Library Agent
[T Legato Agent I™ HDS (HiCommand] Agent [T SMIS Librany fgent
[ “eritas MetBackup Agent I~ LS| Agert
I~ TSM Agent I Netiipp Agent

Select Al Clear Al | < Back | Mest » I Cancel

Figure 12 - Select Features To Be Installed

8. A screen will appear prompting for the type of databases to install support for.
Select SQL and any other databases the agent will be configured to communicate
with.

9. If the Configuration Tool is launched, close its window. You can run the Configuration
Tool from the Storability program folder after you have created the database user,
which is a required configuration parameter.

10. Click OK to view the Readme_dbAgent.txt file.

CREATING THE DATABASE AGENT ACCOUNT
The database agent requires that you create an account for it to use with SELECT
permissions to specific tables, as shown below.
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Permission Object Name Object type Database Name

Select sysservers System table | master

Select sysdatabases System table | master

Select sysprocesses System table | master

Select sysfiles System table | Every database
Select sysfilegroups System table | Every database
Select sysobjects System table | Every database
Select sysindexes System table | Every database
Select sysusers System table | Every database
Select sysprotects System table | Every database

Table 3 — SELECT Permissions to Tables for MS SQL

To avoid using the system account, it is recommended that you create a dedicated
account with only the required permissions.

The Storability Database Agent installation will install a set of utilities in the directory:

..\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent
User Creation Scripts

a. From a command prompt, change directory into the mssql subdirectory of “dbAgent
User Creation Scripts”.

b. View the readme.txt file for notes about the dbagent_mssql_create_user.bat script.
c. Execute the script dbagent_mssql_create_user.bat using the following syntax:

Usage: dbagent_mssql_create_user.bat SERVER DBAGENT_LOGIN DBAGENT_USER
DBAGENT_PWD ADMIN_PWD

Where:
SERVER is your MS SQL SQL database server name or IP address
DBAGENT USER is the name of the account to be created for use by
dbAgent
DBAGENT PWD is the password for DBAGENT USER that will be created.
ADMIN PWD is the password of the “sa” admin account.

For example:

dbagent mssql create user.bat 192.168.1.17 dbagent dbagentpswd
password

CONFIGURING THE DATABASE AGENT FOR MSSQL

1. Launch the Storability Configuration Tool from the Storability Program Folder.
2. Select File ->Edit -> Smart Agent Configuration.
3. Select the Database Agent tab
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Huost Agent rFabric Agert rTSM Agent rSRM Agent rPolicyAgent rScheduIerAgent rDataAggregatorAgent rDataPolling Agent
Routing Agent r LSl Agent r STHLSeries Agent r Database Agent r ESS Agent

License Agent

¥l Save Configuration Settings Current Parameters

Database Ty... (Logical Name IPAddress
[} mssgl 192.168.1.136  [192.168.1.136

Type Logical N.me
W Datahase User Ip Address
N Fort Fassword

Linil DR 3 Submit Cancel

Local Manager Part

|
ol L]

<t

i

<t

| Comments |

| Hide Advanced Settings |

Advanced Settings : Current Parameters Template Parameters
Enable Auto Registration |true
DBA_NUM_ASUS s

Connection Timeout SALServer Only |1D

of| BT BT BT BT

|
|
|
Guery Timeout SALServer Only |5 |
|
|

DBA_TEST_MODE o
DBA_CACHE_EXFIRY_PERIOD [s6400

Table 4 - Database Agent Configuration Tool Window

4. Click the Add button to add another entry to the current configuration.

5. In the Add dialog box that appears, select MSSQL as the type of database to
connect to.

6. In the Database User field, enter the name of the database user account, which
has the required access permissions.

7. In the Port field, enter the TCP port number to connect to the SQL database instance
(typically 1433).

8. Enter the IP Address or the host name for the database server in the Logical
Name field.

9. Enter the IP Address or host name of the database server in the Ip Address field.

10. Enter the password for the database user account in the Password field.

11. Click the Submit button to add the database server to the configuration.

12.In the Local Manager field, enter the network resolvable host name or IP address
for the Local Manager that the Database Agent will contact for agent auto
registration.

13.In the Local Manager Registration Port field, specify the TCP port number the
Local Manager uses for agent auto registration. The default port number is 17146.

14. Click Show Advanced Settings and review/modify the following parameters:

e Enable Auto Registration - Accept that agent auto registration is enabled
(true), or set this parameter to false to disable agent auto registration for the
Database Agent.

e DBA_NUM_ASUS - Number of application units per database in the
gsa_dba_application_storage_unit table; default value is five (5).
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¢ Connection Timeout SQL Server Only - How long (in seconds) the agent tries
to connect to the database; default value is 10 seconds.

e QueryTimeout SQL Server Only - How long (in seconds) the agent waits for
a SQL Query statement to complete; default value is 5 seconds.

e DBA_TEST_MODE - Sets the Database Agent’s operational mode where zero
(0) turns off test mode and one (1) enables it.

e DBA_CACHE_EXPIRY_PERIOD — How long (in seconds) the Database Agent
should keep reporting cached database server information after it receives
errors while retrieving information from a certain database server. The default
value is 86400 seconds.

15. With “Save Configuration Settings” turned on (check mark) select File->Save and
confirm changes to the storability.ini file.

16. Select File->EXxit to close the Configuration Tool.

17.Use the Windows Services panel to start the agent before you verify agent
functionality.

VERIFYING DATABASE AGENT ACCESS PERMISSIONS FOR MSSQL
To verify that the Database Agent is configured with the necessary database access
permissions, check the Message.log for error information. Some notes follow.

¢ When the agent starts, the first message it will log is a startup banner that shows
the agent is started.

e If the agent has been configured properly and can access and authenticate itself to
the database, an informational message similar to the following will be generated:

07/15/2003 11:16:17AM|INFO|0|Connection test
(mssqgl,192.168.0.239,gsm db) : Passed|dbAgent.exe|CDblibHelper.cc|258

o If the username/password supplied to the agent in the storability.ini file there will be
an error similar to the following

07/15/2003 11:14:57AM|INFO|0|Connection test

(mssqgl, 192.168.0.239,gsm db) : Failed: MSSQLDBLibException:dbopen:Login
failed for user 'gsm db'.Severity [14] MsgNum [18456] MsgState

[1] .DBLibrary error: Login incorrect.DB Error [10003] OS Error: not
available. [-1]|dbAgent.exe|CDblibHelper.cc|258

that is followed by a number of other messages for each published table similar to
the following:

07/15/2003 11:14:57AM|ERROR |0 |Exception while serving GSM table:
gsa_dba application storage unit:
Connection(mssgl,192.168.0.239,gsm db) :
D:\release\storability\dev\src\dbAgent\sda\dbapilsrc\mssgl\mssgldbconne
ction.cpp:92:MSSQLDBLibException:dbopen:Login failed for user

'gsm db'.Severity [14] MsgNum [18456] MsgState [1].DBLibrary error:
Login incorrect.DB Error [10003] OS Error: not available. [-

1] |dbAgent.exe|CDblibHelper.cc|562
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e If Microsoft SQL database server is not running, the agent will not be able to connect
with the database and will generate a number of error messages similar to the
following:

07/15/2003 11:25:25AM|INFO|0|Connection test
(mssqgl, 192.168.0.239,gsm db) : Failed:
MSSQLDBLibException:dbopen:DBLibrary error: Unable to connect: SQL

Server 1is unavailable or does not exist. Unable to connect: SQL Server
does not exist or network access denied.DB Error [10004] OS Error:
ConnectionOpen (Connect()). [2]|dbAgent.exe|CDblibHelper.cc|258

e If the agent has been configured with an invalid logical server (IP Address or host
name) for the database (i.e. the system DSN name instead of the hostname or IP
Address of the database server), the agent will not be able to connect with the
database and will generate a number of error messages similar to the following:

07/15/2003 11:25:25AM|INFO|0|Connection test
(mssqgl, 192.168.0.239,gsm db) : Failed:
MSSQLDBLibException:dbopen:DBLibrary error: Unable to connect: SQL

Server 1is unavailable or does not exist. Unable to connect: SQL Server
does not exist or network access denied.DB Error [10004] OS Error:
ConnectionOpen (Connect()). [2]|dbAgent.exe|CDblibHelper.cc|258

e If the database account used by the database agent does not have sufficient select
permissions for a particular object, the agent will generate a number of error
messages similar to the following:

07/15/2003 11:37:41AM|ERROR|0Q|Exception while serving GSM table:
gsa_dba application storage unit:

Connection (mssgl,192.168.0.239,gsm db2):
D:\release\storability\dev\src\dbAgent\sda\dbapilsrc\mssgl\mssgldbstate
ment.cpp:78:MSSQLDBLibException:dbsglexec:Server user 'gsm db2' is not
a valid user in database 'model'.Severity [14] MsgNum [916] MsgState
[1] .DBLibrary error: General SQL Server error: Check messages from the
SQL Server.DB Error [10007] OS Error: not available. [-

1] |dbAgent.exe|CDblibHelper.cc|562

DATABASE AGENT FOR ORACLE

The following sections describe how you install, configure, and verify the Database Agent
for Oracle databases.

ORACLE CLIENT INTERFACE PREREQUISITE

The Oracle Client Interface software must be installed on the server where the
Storability Database Agent is to be installed. If the Oracle Client Interface is installed
the following should exist:

¢ Program Group - The following program group is generally created by the Oracle
Client Interface installation:

E Qracle - OraHomes2 rﬁ Application Development g & S0L Plus
@ Mavisphere r |E Configuration and Migration Tools  ®

Figure 13 - Oracle Client Interface Program Group
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Registry Keys - The following registry keys are created by the Oracle Client
Interface installation:

& Registry Editor = .=.I.EL§{
Registry Edit Wiew Favorites Help

-1 oDBC =] [Mame: Type | Data

23 ORACLE REG_S7 {value not set)

ALL_HOMES [ab] a1 REG_SZ  Ciloracleloras2idbs

oD inst_loc REG_5Z C:\Program FilesiOracle\Inventory

- ese A

| —— ORACLE_GROUP_NAME REG_SZ  Oracle - OraHomed2
-3 RET ORACLE_HOME REG_5Z Cihoraclelorasz

. Rosmabout [B]ORACLE_HOME_MAME  REG 52 OraHomedz
-1 53

-] Seagate Software

Secure

-2 55H Communications Security
-] Storabilicy

-7 Storage

(7] SYBASE

Wierpaink

(1] Wisia

[ Woice ;I _¢| |

My Computer|HKEY_LOCAL_MACHINE\SOFTWARE|ORACLE

NIE

Figure 14 - Oracle Client Interface Registry Keys

e Service Name configured - Verify that a Service Name is configured for the
database you wish to connect to.

From the Oracle program group, launch the Oracle Net Manager. Expand the Service
Naming tree and an entry should exist for each of the Oracle Service Names
configured:

r:“ Oracle Net Manager - C:oracle',ora92 \ NETWORK  ADMIN',

File Edit nand Help
-2 Oracle Net Configuration s dentification

Local
@Proﬂle arme; orad1b

g Senice Naming |
il U4 | Database Default r
4 Listeners

B Oracle Names Servers ompatible Identi

nfiguration

Address 1

Protocol: TCRIP
Hast Marme: 1D_.255_.252.1 54
Fort Murmber: 1521

Figure 15 - Oracle Net Manager
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Notes: If you can’t find or open the Oracle Net Manager, you can also check the Oracle
configuration file, tsnames.ora, to see if a service name has been defined for the
database. The tsnames.ora file is typically located in the
C:\oracle\ora92\network\ADMIN directory and would contain an entry similar to
the following for each service name:

ORA816 =
(DESCRIPTION =
(ADDRESS LIST =
(ADDRES = (PROTOCOL = TCP) (HOST = 10.255.252.154) (PORT =

1521))

)
(CONNECT DATA =
(SERVICE NAME = ora816)

)

If an Oracle Service Name does not exist for the database, you must first create it. The
following steps provide instructions on creating a Service Name with the Oracle Net

Manager.

1. Start the Oracle Net Manager from the Oracle Configuration and Migration

Tools Folder.
2. Click on the Service Naming folder and then click the green + button on the left to

add a new name.

=% Qracle Met Configuration

THog Oracle Mames Servers

Figure 16 - Creating a Service Name Using Net Manager

3. The Net Service Name Wizard will appear. Enter a service name (which should
match the instance name of the database you are connecting to) and click Next.
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Net Service Name Wizard, page 1 of 5: Net Service Name 5[

To access an Oracle database, or other service, across the network
wou use a net service name. This wizard will help vou create a net
Service name.

Enter the name you wantto use to access the databhase aor service. It
can be any name you choose,

Met Service Mame:

Figure 17 - Net Service Name
4. On step 2 of the wizard, select TCP/IP (Internet Protocol) and click Next.

5. On step 3 of the wizard enter the IP Address or hostname of the server where the
database is running, the port humber (1521 by default), and click Next.

MNet Service Mame Wizard, page 3 of 5: Protocol Settings 0 ﬂ |

To cammunicate with the database using the TCPAP protocal, the
database computer's host name is required. Enter the TCPIIP host
name for the camputer where the database is located.

Host Marme: 10.285.252.154

ATCPRIAR port number is also required. The port number for Oracle
databases is usually 1521, You should not normally need to specify a
different port numhber.

Port Murnber: 1571

- Cance “  Back I [ ext ))'

Figure 18 - Protocol Settings

6. On step 4 of the wizard, enter the service name for the database and click Next.
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Met Service Name Wizard, page 4 of 5: Service ll

To identify the database or service you must provide either its service
narme, far Oraclesi 8.1 or later, or systern identifer (5100, for Oracled 8.0
database versions. The service name for an Oracledi or later database
is normally its alobal database name.

@ (Oracle8ior latery Serice Mame: |ora816|

 {Dracled or Previous) SI0O: [ORCL

Cptionally, you can choose ifyou want a shared or dedicated server
database connection. The default is to letthe database decide.

Connection Type: [Database Default -

Zancel Back I Next 2 )

Figure 19 - Service Name

7. On step 5, click Test to test the database connection. Use the account created for
the agent to perform the connectivity test to validate that the username and
password are valid.

8. After you've completed the wizard, the Oracle Net Manager should then have a
listing for the service names you’ve just created.

racle Net Manager - C:ioracle',ora92 \NETWORK' | ADMINY,
File Edit Command Help
@-@ Oracle Met Configuration
Local
S
@ Service Naming = L g
Léla orast b Connection Type:

4 Listeners
B Oracle Names Servers 18] \patible Identification

entification

Address 1

Protocal: TCFRIP
Host Name: 10.255.252.154
Port Mumber: 1521

Figure 20 - Verifying Service Name Using Net Manager
9. You can test the new connection you’ve created using SQLPlus.
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[+ oracle saL*Plus
File Edit. Search Options  Help

User Name; |gsa_dhaccess_user

LLLLLLLLLL LT LT
Password: |

Host String: |uraB]B

0K I Cancel

Figure 21 - Using SQLPIlus to Test Connection

If the username and password you've supplied are valid, the following screen should
appear.

I Z oracle SQL*Plus

Flle Edit Search Options Help

SQL=Plus: Release 9.2.8.1.8 - Production on Fri Jun é 16:48:21 2083
Copyright (c) 1982, 2882, Oracle Corporation. A1l rights reserved.
Connected to:

Oracle8i Enterprise Edition Release 8.1.6.8.8 - 64bit Production
With the Partitioning option

JServer Release 8.1.6.0.8 - Production

sQL>

Figure 22 - Connection Verification Screen Using SQLPlus

10.You can now issue SQL commands to verify the account has the required access
permissions. For example:

SQL> select * from DBA DATA FILES;

FILE NAME

FILE ID TABLESPACE NAME BYTES BLOCKS
STATUS
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RELATIVE FNO AUT  MAXBYTES MAXBLOCKS INCREMENT BY USER BYTES
USER BLOCKS

/export/home/oracle/oradata/ora8l6/tools01.dbf
2 TOOLS 10485760 1280
AVATILABLE
2 YES 3.4360E+10 4194302 40 10477568
1279

/export/home/oracle/oradata/ora816/drsys01.dbf
7 DRSYS 20971520 2560
AVAILABLE

7 YES 3.4360E+10 4194302 80 20963328
2559

INSTALLING THE DATABASE AGENT FOR ORACLE - WINDOWS

This section describes how to install and configure the Database Agent on a Windows
platform.

1. Insert the Windows Local Manager CD into the CD-ROM drive.

2. Click Next on the Welcome menu to continue the installation.

3. Click Yes to accept the terms of the software license agreement.

4. Click Next.

5. Review/modify the User Name and Company Name and click Next.
6. Click Next to accept the default destination folder.

7. A screen listing the components available for installation will then appear. Check the
Database Agent box to install the Database Agent.
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InstallShield Wizard |
Sun StorageTek™ Business Analytics
SETUP

Select features to be installed and click Mext.
Y'ou can choose not o install this application by clicking on Cancel to exit Setup.
| Local kanager | D atabaze [ HPF Agent
[T Routing Agent [T Databaze Agent [ Celerra Agent
™ Prasy Agent | Array [~ SHIS Array Agent
| Haoszt [ Clariion Agernt -

rc P | Fabric

ompag Agen

I Host Agent [~ Fabiic &gent
™ SRM Agent [T Compag E¥d &gent
[T Remate Host Agent I EMC Agent | Tape Library

[T ESS Agent [T STE Libramy &gent
| Backup [T HDS [DAMP) Agent [T IBM 3494 Library &gent
[T Legato sgent I™ HODS [HiCommand) Agent [T SIS Library &gent
[~ Weritas MatB ackup Agent I~ LSl Agent
[~ TSM Agent I Netpp Agent

Select All Clear Al | < Back | Mest » I Cancel

Figure 23 - Agent Selection Dialog

8. A screen will appear prompting for the type of databases to install support for.
Select Oracle and any other databases the agent will be configured to communicate
with.

9. If launched, close the Configuration Tool. You can launch the Configuration Tool after
you have created the Database User, which is a required configuration parameter.

10. Click OK to view the Readme_dbAgent.txt file.

CREATING THE DATABASE AGENT ACCOUNT

The database agent requires that you create an account for it to use with SELECT
permissions to specific tables. Permissions are granted using the Object Name, but the
database selects are done using the Referenced Alias Name. The queries that the
dbAgent uses rely on the default public synonyms for the V$ views being present for the
tables that are identified below.
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Permission Object Name Referenced Alias Object type | Owner
Name Name
Select V_$INSTANCE V$INSTANCE System view sys
Select DBA_DATA_FILES DBA_DATA_FILES System view sys
Select DBA_FREE_SPACE DBA_FREE_SPACE System view sys
Select V_$FILESTAT V$FILESTAT System view sys
Select V_$DATAFILE V$DATAFILE System view Sys
Select V_$PARAMETER V$PARAMETER System view sys
Select V_$SESSION V$SESSION System view sys
Select DBA_USERS DBA_USERS System view sys
Select DBA_INDEXES DBA_INDEXES System view sys
Select DBA_VIEWS DBA_VIEWS System view sys
Select V_$TABLESPACE V$TABLESPACE System view sys
Select V_$CONTROLFILE V$CONTROLFILE System view sys
Select V_$LOGFILE V$LOGFILE System view Ssys
Select DBA_TEMP_FILES DBA_TEMP_FILES System view sys
Select V_$TEMPSTAT V$TEMPSTAT System view Sys
Select V_$TEMPFILE V$TEMPFILE System view Sys
Select V_$LOG V$LOG System view sys
Select DBA_ALL TABLES DBA_ALL TABLES System view sys
Select V_$CONTROLFILE_RE | V$CONTROLFILE_RECO System view sys
CORD_SECTION RD_SECTION
Select DBA_TABLES DBA_TABLES System view sys

Table 5 - SELECT Permissions for Oracle

The Storability Database Agent installation will install a set of utilities in the directory:

..\Storability\GSM\Utilities\Storability Local Manager Utilities\dbAgent
User Creation Scripts

To use the scripts, proceed as follows:

a. Change directory to the oracle subdirectory of "dbAgent User Creation Scripts”.

b. View the readme_windows.txt file for notes about the
dbagent_ora_create_user.bat script.

c. Execute the script, dbagent_ora_create_user.bat, using the following syntax:

dbagent ora create user.bat SERVER DBAGENT USER DBAGENT PWD
ADMIN PWD

Where: only ADMIN_PWD may be empty. For example:

dbagent ora create user.bat ora8l6 gsa dbaccess user
<password> <sys passwd>

CONFIGURING THE DATABASE AGENT FOR ORACLE - WINDOWS

D WNR
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Launch the Storability Configuration Tool from the Storability Program Folder.
Select File ->Edit -> Smart Agent Configuration.
Select the Database Agent tab
Click the Add button to add another entry to the current configuration.
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10.
11.
12.
13.

14.

From the Add dialog box that appears, select Oracle as the type of database to
connect to.

In the Database User field, enter the name of the database user account, which
has the required access permissions.

In the Port field, enter the port number to connect to the oracle database (typically
1521).

Enter the logical name of the oracle database in the Logical Name field. This
should match the service name created with the Oracle Net Manager for the
database.

Enter the IP Address of the database server in the Ip Address field.

Enter the password for the database user account.

Click the Submit button to add the database server to the configuration.

In the Local Manager field, enter the IP address or host name for the Local
Manager that the agent will contact for agent auto registration.

In the Local Manager Port field, specify the TCP port humber the Local Manager
uses for agent auto registration. The default TCP port humber is 17146.

Click Show Advanced Settings and review/modify the following parameters:

¢ Enable Auto Registration - Accept that auto registration is enabled (true) or
set this parameter to false to disable auto registration.

e DBA_NUM_ASUS - Number of application units per database in the
gsa_dba_application_storage_unit table; default value is five (5).
Connection Timeout SQL Server Only - Only used for MS SQL Server.

¢ QueryTimeout SQL Server Only - Only used for MS SQL Server.

e DBA_TEST_MODE - Sets the Database Agent’s operational mode where zero
(0) turns off test mode and one (1) enables it.

e DBA_CACHE_EXPIRY_PERIOD — How long (in seconds) the Database Agent
should keep reporting cached database server information after it receives errors
while retrieving information from a certain database server. The default value is
86400 seconds.

18. With “Save Configuration Settings” turned on (check mark) select File->Save
and confirm changes to the storability.ini file.

19. Select File->Exit to close the Configuration Tool.

20. Use the Windows Services panel to start the agent before you verify agent
functionality.

VERIFYING THE DATABASE AGENT ACCESS PERMISSIONS FOR ORACLE
Check the contents of the Message.log file for errors. The following notes apply to
checking messages:

¢ When the agent starts, the first message it will log is a startup banner that
indicates the agent has started.

¢ If the agent has been configured properly and can access and authenticate itself to
the database, an informational message similar to the following will be generated:

06/09/2003 12:27:49PM|INFO|0|Connection test (oracle,ora8lo6,
gsa_dbaccess_user) :Passed|dbAgent.exe|CDblibHelper.cc|258

If the username/password supplied to the agent in the storability.ini file is invalid,
there will be a humber of error messages similar to the following:

06/09/2003 11:41:33AM|ERROR|0|Exception while serving GSM table:
gsa_dba_ database server: Connection(oracle,ora8l6,gsa dbacess user):
D:\ga\storability\dev\src\dbAgent\sda\dbapilsrc\oracle\oradbconnection
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.cpp:124:0CIException:0CISessionBegin:ORA-01017: invalid
username/password; logon denied|dbAgent.exe|CDblibHelper.cc|562

e If the Oracle TNS listener is not running on the database server, the agent will not
be able to connect with the database and will generate a number of error messages
similar to the following:

06/09/2003 11:38:44AM|ERROR|0|Exception while serving GSM table:
gsa_dba database server: Connection(oracle,ora8l6,gsa dbacess user):
D:\ga\storability\dev\src\dbAgent\sda\dbapilsrc\oracle\oradbconnection
.cpp:100:0CIException:0CIServerAttach:0RA-12541: TNS:no listener
|dbAgent.exe|CDblibHelper.cc|562

e If the agent has been configured with an invalid logical server (service name) for
the database, the agent will not be able to connect with the database and will
generate a number of error messages similar to the following:

06/09/2003 13:02:55PM|INFO|0|Connection test (oracle,bogusname,
gsa_dbaccess_user) :Failed: OCIException:0CIServerAttach:0RA-12154:
TNS:could not resolve service name|dbAgent.exe|CDblibHelper.cc|258

. If the Oracle Service has not been defined on the system the agent is installed
on, the agent will not be able to connect with the database and will generate a
number of error messages similar to the following:

06/09/2003 13:54:50PM|INFO|0|Connection test (oracle,ora%9011,
gsa_dbaccess user) :Failed: OCIException:0CIServerAttach:0RA-12154:
TNS:could not resolve service name|dbAgent.exe|CDblibHelper.cc|258

. If the database account used by the database agent does not have sufficient
select permissions for a particular object, the agent will generate a number of error
messages similar to the following:

06/09/2003 14:01:39PM|ERROR|0|Exception while serving GSM table:
gsa_dba logical storage unit:

Connection (oracle,mydb,gsa dbaccess user):
D:\ga\storability\dev\src\dbAgent\sda\dbapi\src\oracle\oradbresultset.
cpp:243:0CIException:0CIStmtExecute:0ORA-00942: table or view does not
exist

| dbAgent.exe|CDblibHelper.cc|562

If the Oracle Client Interface software is not installed on the server where the agent has
been installed, the following error message will pop-up on the console when the agent is
started:

dbAgent.exe - Unable To Locate DLL 3 x|

The dynamic link library OCIdll could mot be Found in the specified path C:\Program
Files\StarabilityiGsMiAgents| Storability Database
Agent; s COWINNTI Sy sbem32; CWINNT systemCWINNT Ci\Program Files!Seagate SoftwareiNOTESY, C:\Program
Files\3eagate Software\NOTESIDATALCWINNT syvekem32; C M INNT ;0 WINMNTY System 32\ ebem; C:\Program
FilesiMicrosoft 0L Serveri80i Tools\Binnf,
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DATABASE AGENT FOR SYBASE - WINDOWS

The following sections describe how you install, configure, and verify the Database Agent
for Sybase.

SYBASE OPEN CLIENT PREREQUISITE

The Sybase Open Client software must be installed on the server where the Storability
Database Agent is to be installed. If the Sybase Open Client software is installed the
following should exist:

e Default Directory - The Sybase Open Client installation does not typically create a
program menu group, but the default directory is c:\Sybase. Additionally, the
installation should also add its DLL and BIN sub-directories to the system PATH

variable.
¢ Registry Entries - The following registry keys are created by the Sybase client
installation:
2 Registry Editor 1 =lalx]
Registry  Edit  View Favorites  Help
] =-( svBAsE | | Type | Data

REG_SZ {walue not set)
REG_3Z ci\Program Files\sybase\OLEDE-2_1

B (23 open Client

! {2 Metwork Library For Mai
L Metwork Libeary For Wit
-2 Open Clisnt (required
5 (21 50K {include and library

= i_'l Viewpoink
-] Wisio
-] Voice

] [:l Windows 3.1 Migration Status
© - SvsTEM

=-{ HKEY_USERS =
I s T
« B | _»F' « ol

My ComputeriHKEY_LOCAL_MACHINE\SOFTWARESYBASEIOLE DB 4

Figure 24 - Sybase Open Client Registry Entries

o Data Server name defined - Verify that a Service Name is configured for the
database you wish to connect to.

1. From a command prompt, run dsedit.exe.

2. In the Server list on the left, locate the name of the Sybase server you wish to
connect to and click it. The server address field should report the IP Address and
port number for the Sybase server you want to connect to.

Notes: If you can't find or open DSEDIT, you can also check the Sybase configuration
file, sql.ini, in the <install path>\sybase\ini directory to see if an interface has been
defined for the database.

The following steps provide instructions on creating a Service Name using DSEDIT.

1. Start dsedit.exe (located in <installed drive>:\Sybase\ OCS-12_x\bin).

2. When prompted for a Directory Service to open, select InterfacesDriver and click
OK.

3. Click in the server frame on the right.

4. Select Server Object and choose Add.

5. In the Input Server Name dialog, type the Server Name you want to use to refer to
the database server and click OK.
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10.
11.

12.

EE'DSEDIT1 - InterfacesDriver -0l x|
Server Aftributes Yalues
_ Server Entry Yersion 1
test Server Name rock
docs Server Service SQL Server
Server Status 4 Unknown
Server Address TCP-192.168.0.55,4100
Path
rock

Figure 25 - dsedit InterfaceDriver

Click the newly created Server in the left frame to select it.

Right-click on the Server Address line in the frame on the right, and select Modify
Attribute from the menu.

Click the Add button and then select TCP as the Protocol using the list box.

Enter the IP Address of the server followed immediately by a comma and the TCP
port for the database (typically 4100).

Click OK twice to complete the configuration of the Server entry.

Right click on the newly created Server entry and select Ping Server. A Ping window
will appear. Click the Ping button to test the connection to the Service entry. A
success or failure message will then appear.

If successful. you should now be able to use the new Service hame with isql to
connect to the database. For example:

isgl -U<sa> -P<sa password> -S<name of server entry created above>

INSTALLING THE DATABASE AGENT FOR SYBASE - WINDOWS

This section describes how to install and configure the Database Agent on a Windows
platform.

1.

Insert the Sun StorageTek Business Analytics Windows Local Manager CD into the
CD-ROM drive.

Click Next on the Welcome menu to continue the installation.

Click Yes to accept the terms of the software license agreement.
Review/modify the User Name and Company Name and click Next.
Click Next to accept the default destination folder.

A screen listing the components available for installation will then appear. Check the
Database Agent box to install the database agent.
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7. A screen will appear prompting for the type of databases to install support for.
Select Sybase any other databases the agent will be configured to communicate
with.

8. If launched, close the Configuration Tool.
9. Click OK to view the Readme_dbAgent.txt file.
CREATING THE DATABASE AGENT ACCOUNT

The Database Agent requires that you create an account for it to use with SELECT
permissions to specific tables that are identified below.

Permission Object Object type Database Name
Name
Select sysconfigures | System table | Master
Select sysservers System table | Master
Select sysdevices System table | Master
Select sysusages System table | Master
Select sysdatabases | System table | Master
Select spt_values User table Master
Select syslogins System table | Master
Select sysprocesses | System table | Master
Select sysobjects System table | Every database
Select syssegments | System table | Every database
Select sysusers System table | Every database
Select sysindexes System table | Every database
Select sysprotects System table | Every database

Table 6 - SELECT Permissions for Sybase

The Storability Database Agent installation will install a set of utilities in the directory:

..\Storability\GSM\Utilities\Storability Local Manager
Utilities\dbAgent User Creation Scripts

To use the scripts, proceed as follows:

1. Change directory to the ..\Storability\GSM\Utilities\Storability Local Manager
Utilities\dbAgent User Creation Scripts.

2. View the readme_windows.txt file for notes about the
dbagent_sybase_create_user.bat script.

3. Execute the script, dbagent_sybase_create_user.bat. using the following syntax:

dbagent sybase create user.bat SERVER DBAGENT USER DBAGENT PWD
ADMIN PWD

Where: only ADMIN_PWD may be empty.

For example:

dbagent sybase create user.bat dbsyb3 dbagent <password> <sa passwd>
CONFIGURING THE DATABASE AGENT FOR SYBASE - WINDOWS

1. Launch the Storability Configuration Tool from the Storability Program Folder.
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10.
11.
12.
13.

14.

15.

16.
17.

Select File ->Edit -> Smart Agent Configuration.

Select the Database Agent tab

Click the Add button to add another entry to the current configuration.

In the Add dialog box that appears, select Sybase as the type of database to
connect to.

Enter the name of the database user account, which has the required access
permissions.

Enter the port number for the Sybase database (typically 4100).

Enter the logical name of the Sybase database in the Logical Name field. This
should match the service name created with the dsedit utility for the database.
Enter the IP Address of the database server.

Enter the password for the database user account.

Click the Submit button to add the database server to the configuration.

In the Local Manager field, enter the network resolvable host hame or IP address
for the Local Manager with which the Database Agent is to register if auto
registration is enabled.

In the Local Manager Port field, accept the default TCP port number of 17146 for
the Local Manager.

Click Show Advanced Settings and review/modify the following parameters:

¢ Enable Auto Registration - Accept that auto registration is enabled (true) or
set this parameter to false to disable agent auto registration.

e« DBA_NUM_ASUS - Number of application units per database in the
gsa_dba_application_storage_unit table; default value is five (5).

¢ Connection Timeout SQL Server Only - How long (in seconds) the agent tries
to connect to the database; default value is 10 seconds.

¢ QueryTimeout SQL Server Only - How long (in seconds) the agent waits for a
SQL Query statement to complete; default value is 5 seconds.

e DBA_TEST_MODE - Sets the Database Agent’s operational mode where zero (0)
turns off test mode and one (1) enables it.

e DBA_CACHE_EXPIRY_PERIOD - How long the Database Agent caches its
collected data.

With “Save Configuration Settings” turned on, select File->Save and confirm
changes to the storability.ini file.

Select File->EXxit to close the Configuration Tool.

Use the Windows Services panel to start the agent before you verify agent
functionality.

VERIFYING THE DATABASE AGENT ACCESS PERMISSIONS FOR SYBASE
Check the contents of the agent’s Message.log file for errors:

When the agent starts, the first message it will log is a startup banner that
indicates the agent started.

If the agent has been configured properly and can access and authenticate itself to
the database, an informational message similar to the following will be generated:

06/16/2003 14:05:54PM|INFO|0|Connection test (SYBASE,dbsyb3, gsmdb)
:Passed|dbAgent.exe|CDblibHelper.cc|258

If the database agent has been configured with an invalid Data Server Interfaces
entry (for the Logical Server name), or an incorrect username/password
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combination, the database agent will not be able to connect with the database and
will generate a number of error messages similar to the following:

06/16/2003 14:06:52PM|INFO|0|Connection test
(SYBASE, dbsyb5,gsmdb) :Failed: SybaseException:Error: Connecting to
database (ct _connect) |dbAgent.exe| CDblibHelper.cc|258

06/16/2003 14:06:52PM|ERROR |0 |Exception while serving GSM table:

gsa dba application storage unit: Connection (SYBASE, dbsyb5,gsmdb) :
D:\ga\storability\dev\src\dbAgent\sda\dbapi\src\sybase\sybdbconnecti
on.cpp:8l: SybaseException:Error: Connecting to

database (ct_connect) |dbAgent.exe| CDblibHelper.cc|261

06/16/2003 14:06:52PM|ERROR |0 |Exception while serving GSM table:
gsa_dba_application_storage_unit: Connection (SYBASE, dbsyb5, gsmdb) :
D:\ga\storability\dev\src\dbAgent\sda\dbapi\src\sybase\sybdbconnecti
on.cpp:8l:SybaseException:Error: Connecting to

database (ct _connect) |dbAgent.exe| CDblibHelper.cc|562

06/16/2003 14:06:52PM|INFO|0|Error:Closing connection to
database (ct close) ||eventlogadapter.cpp|68

If these error messages are encountered:

1. Verify that the data service was setup correctly. Use the Sybase dsedit tool to ping
the server.

2. Verify that the username and password used by the agent are correct. Use isql to
login to the database:

isql -U<db_agent_account> -P <db agent account password> -S<logical
server>

1> select * from sysservers
2> go

If the database account used by the database agent does not have sufficient select
permissions for a particular object, the agent will generate a number of error messages
similar to the following:
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06/16/2003 14:42:31PM|INFO|0|Unexpected error during data
availability check | |eventlogadapter.cpp|68

06/16/2003 14:42:32PM|ERROR|0|Exception while serving GSM table:
gsa_dba application storage unit: Connection (SYBASE,dbsyb3,portal):
D:\ga\storability\dev\src\dbAgent\sda\dbapilsrc\sybase\sybdbresultse
t.cpp:160:SybaseException:Client Library error: severity(l)

number (155) origin(l) layer(l) Error text: ct results(): user api
layer: external error: This routine cannot be called when the
command structure is idle.|dbAgent.exe| CDblibHelper.cc|562

06/16/2003 14:42:34PM|INFO|0|Unexpected error during data
availability check | |eventlogadapter.cpp|68

06/16/2003 14:42:34PM|ERROR|0|Exception while serving GSM table:
gsa_dba db specific data: Connection (SYBASE,dbsyb3,portal):
D:\ga\storability\dev\src\dbAgent\sda\dbapilsrc\sybase\sybdbresultse
t.cpp:160:SybaseException:Client Library error: severity(l)

number (155) origin(l) layer(l) Error text: ct results(): user api
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layer: external error: This routine cannot be called when the
command structure is idle. |dbAgent.exe| CDblibHelper.cc|562

If the Sybase Open Client software is not installed on the server where the agent has
been installed, the following error message will pop-up on the console (or will be present
in the System Event Log) after the agent is started:

Application popup: dbAgent.exe - Unable To Locate DLL: The dynamic
link library libcs.dll could not be found in the specified path
C:\Program Files\Storability\GSM\Agents\Storability Database

Agent; .;C:\WINNT\System32;C:\WINNT\system;C:\WINNT;C:\Program
Files\Seagate Software\NOTES\;C:\Program Files\Seagate
Software\NOTES\DATA\; C: \WINNT\system32;C:\WINNT;C:\WINNT\System32\Wb
em; C:\Program Files\Microsoft SQL Server\80\Tools\Binn\.

If these error messages are encountered, verify that the Sybase Open Client is installed
correctly and that the libcs.dll library, installed by Sybase, isl located in the system
PATH.

DATABASE AGENT FOR ORACLE - SOLARIS

This section describes how you install, configure, and verify the Database Agent for
Oracle on Solaris.

DATABASE AGENT PREREQUISITES

Before installing the Database Agent for Oracle, verify the following prerequisites:

¢ Working installation of SQLPLUS - The installation of the database agent requires
a working sqlplus available on the server. Ensure that the Oracle sqlplus utility is
included in the PATH variable and that the required Oracle environment variable is
set (e.g. ORACLE_HOME/bin dir is in the PATH, ORACLE_HOME/Iib dir is in
LD_LIBRARY_PATH)

e Service Name Configured - The installation and use of the database agent
requires a service name be configured for the database server instance.

a. Using SQLPLUS, verify that you can connect to the service name or check the
contents of the $ORACLE_HOME\network\admin\tnsnames.ora, and verify that the
service name exists in the file.

For example:

ORA816 =
(DESCRIPTION =
(ADDRESS LIST =
(ADDRESS = (PROTOCOL = TCP) (HOST = db-gaZ2) (PORT = 1521))
)
(CONNECT DATA =
(SERVICE NAME = ora816)
)
)

INSTALLING THE DATABASE AGENT - SOLARIS
The Database Agent requires the following four Sun StorageTek Business Analytics
packages to be installed on the Solaris server:

e GSMbase
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e  GSMImutil
e GSMdb
e GSMoracle

In addition to these packages, the Host Agent (GSMhost) package is typically installed

as well.

1. Mount the Local Manager CD on the server where the agent is to be installed. For

example:

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom

1. Change the directory to /cdrom/Unix (/cdrom/cdrom/Unix, if it is automounted):

# cd /cdrom/Unix

2. Change the directory to the directory corresponding to the host’s Operating System.

# pwd
/cdrom/Unix/Solaris/8

rootlsymmsun0lg 1=

Tix

rootfzvmmaunil# od Thix
rootfzvmmaunll# cd Solariass
rootizymmaunllsd 13

G3Macsls F3Mcpgewa GSMhds
Galbasze GFRMdAL GHMhicmd
G5Mclarii  GiMenc GSMhost
G5Mclra GaMess GSMhpxp
GSMepdg GSHfaEric GiMibmatl

F3Mlegato
FEMlnutcil
GEM1si5Z1
GEM1=i530
G5M12i533

FaMlsisi3e
FaMl=sis4an
FaMnbu

FaMnetapp
GEMoracle

CiMproxy
FiMroute
GiMarm
GiMstats
GaMatk

GiMzybasze
sToconsrv

Figure 26 - Host OS Directory

3. Install the GSMbase, GSMImutil, GSMdb, and GSMoracle packages. If the GSMbase

and or GSMImutil packages are already installed, the installation will display an

informational message stating the package(s) are already installed.

# pkgadd -d . GSMbase GSMlmutil GSMdb GSMoracle
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10.

11.

12.

13.

rootisymmsun0l# pkgadd -d . G3Mbase G3Mlmutil G3Mdb G3Moracle
Proceszsing package instance «<G5Mbasze: from < cdromsUnix/Solariss8-

Gtorability 3M base

[sparc) prod-4.0.36-da

Copyright (c) 2002 3torability, Inc
411 Rights Reserwved

This is licensed software. By installing this software wou agree
to the terms of the license agreement ihcluded with the package in
Jopt/etorability/GEN-1license. tit

G3Mbase was built on 3und3 5.7.

Please enter the path where Flobal Storage Manager should be
installed. If you enter a path other than Afopt/storability, a
symbolic link will be created to foptsstorability from the real

install location.

Install path? [/app/storabilicy] [2] []

Figure 27 - Installation Directory

Enter a different installation location or press Enter to accept /app/storability. As the
screen displays, a symbolic link will be made to /opt/storability from the installation
path you specify.

Specify whether (y/n) to enable agent auto registration (default) or type n and press
Enter to disable agent auto registration.

Specify the IP address or network resolvable host name of the Local Manager to be
contacted for agent auto registration or press Enter to specify the local host
(default).

Type the TCP Port Number the Local Manager uses for agent auto registration or
press Enter to specify the default port number (17146).

Read the information on how agents that do not require root privileges will be run
under a dedicated account. The default account is username “gsm” and group “gsm”.
The default Group ID is 1090.

Enter a group name to be used for ownership of gsm files or press Enter to use the
default group (gsm). If the group was not created already, specify whether (y/n) the
installation is to create it.

Type Group ID for the group or press Enter to accept the default GID (1090).

Specify whether (y/n) the Agent Monitor will restart the agent if it is detected as not
running.

If the installation directory does not exist, specify whether (y/n) to have it created.

Specify whether (y/n) to have the installation of GSMbase continue.
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14. The installation will proceed and the GSMImutil package is next processed.

Installation of «<G5Mbase> was successful.
Proceszing package instance <GEMlmutil> from «/cdrom/Thix/3olaris/ 8>

Storability G3IM Local Mahager utilities
[eparc) prod-4.0,36-ga

Copyright (c) 2002 Storability, Inc

411 Rights Reserwved

Thiz is licensed software. By installing this software you agree
to the terms of the licehse agreement included with the package in

JSoptistorability/GEM-1license. txt

GAMlmatil was built on 3unls 5.7.

Figure 28 - GSMbase Install Completed

15. The installation checks to determine if the username, gsm, exists. If not, specify
whether (y/n) to create the user.

16. Specify the User ID for the user or press Enter to accept the default User ID (1090).

17. Specify whether (y/n) to continue with the installation of GSMImutil.

Agents which do not require root privileges will be run under a dedicated
account [default username oswm, group ogsSm).

Tsername for GSM files? [gsm]

uzer 'gsm' does not yet exist

Automatically create account? [n] [¥.n,7]
A 'gsm' account, member of the group 'gswm' must be created before this

Figure 29 - GSMImutil Installation
18. Type y and press Enter to review/modify the Advanced Settings.

e Specify whether (y/n) the Agent Monitor will be used to restart the agent if it is
detected as not running.

e Specify whether agent auto registration is turned on (default) or off.

e Specify the IP address or network resolvable host name of the Local Manager to
contact for agent auto registration. The default value is local host.

e Specify the TCP port number the Local Manager uses for agent auto
registration. The default port number is 17146.
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Processing package instance «<G3Mdb> from </cdrom/Thix/3olarissg-
Storabilitcy G5M Database bgent

[sparc) prod-4.0.36-qa

Copyright (o) 2002 Storability, Inc

411 Rights Beserved

This is licensed software. By installing this software ywou agree
to the terms of the license agreement included with the package in
Jopt/etorability/GEM-licensze. txt

GEMdb was built on Sun05 5.7.

The 'advanced' settings all have reasonable default values, which most
likely need not be changed.

Modify adwanced settings? [n] [¥.n,?] ¥
Automatically restart this agent from agentMonitor? [v] [v.n,?]

Enable automatic agent registration? [v] [¥.n,?]

Local Manager address for agent registration? [localhost]

Figure 30 - GSMdb Installation

19. Specify whether (y/n) to continue with the GSMdb installation.

TCP port for agent registration: [17146] [#]
Using </app/storability®> as the package base directory.
## Processing package information.
## DProcessing system information.
6 package pathnames are already properly installed.
## Verifving package dependencies.
## Verifving disk space requirements.
## Checking for conflicts with packages already installed.
## Checking for setuid/setgid programs.

Thiszs package contains scripts which will be executed with super-user
permizsion during the process of installing this package.

Do you want to continue with the installation of <G3Mdb> [v,1n,7] I

20. If the installation continues, the GSMoracle package is next processed.

21. For “"Name of the Oracle database”, enter the service name of the Oracle instance.

22. When prompted, enter the username and password for the GSM database agent
to use when connecting to the Oracle database.

23. Press Enter and confirm the password.

Record the username and password information so that this information will be
available when you create the Database Agent’s account during the next step in
the procedure.

Username:
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Password:

24. Repeat the above procedure to configure all the database instances.
25. Press Enter on a blank "*Name of the Oracle database” line to indicate you have
finished configuring database instances.

IF address of database server: 192.165.0.52
TCP port of database servers [1521] [=#]

Mame of the Oracle databaser [done]

Where is Oracle home? [Aexport/homesoracle] [#,0] AappsforaSle/products8.1.6

[Fe-)start agents after install [v] [¥.0.2.0]
Using < app/sstorability> as the package base directory.
## Processing package information.
## Processing system information.
g package pathnames are already properly installed.
## Verifvyving package dependencies.
##% Verifying disk space requirements.
## Checking for conflicts with packages already installed.
## Checking for setuid/s/setgid programs.

This package contains scripts which will be executed with super-user
permission during the process of installing this package.

Do wou want to continue with the installation of <G3Moracle> [v.n,2] Yl

Figure 31 - GSMoracle Package Installation

26. Enter the directory path for the Oracle Home directory and press Enter.

27. When prompted, enter y to start the installed agents after installation has
completed.

28. Specify whether (y/n) to continue installing the agent, when prompted.

29. The installation proceeds and returns you to the main package installation menu.

30. Select another GSM package to install, or type CTRL-D and q to exit.

CREATE DATABASE AGENT’S ACCOUNT ON SOLARIS - ORACLE

The Database Agent requires an account with SELECT permissions to specific tables. To

avoid using the system account, it is recommended that you create a dedicated account

with only the required permissions.

The Storability Database Agent installation will install a set of utilities and readme files
under the directory:

/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the Oracle user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

Change user to the oracle account.

Read the Readme.db_perms.oracle file located in /opt/storability/etc/dbAgent
directory.

5. Run the create user.oracle.sh script:

Hw

# su - oracle
# /opt/storability/etc/dbAgent/dbagent ora create user.sh <SERVER>
<DBAGENT USER> <DBAGENT PWD>
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Where:

e SERVER = The service name for the Oracle Instance.
DBAGENT_USER = The username of the database account to create for the
Database Agent.

DBAGENT_PWD = The password for the database account being created.

At the “Enter Password:” prompt, enter the password for the sys account.

DATABASE AGENT FOR SYBASE - SOLARIS

This section describes how you install, configure, and verify the Database Agent for
Sybase on Solaris.

DATABASE AGENT PREREQUISITES

Before installing the Database Agent for Sybase, verify the following prerequisites:

10.

11.

12.

13.

Sybase Open Client - The Sybase Open Client software must be installed on the
server where the Database Agent is to be installed.

Service Name Configured - The installation and use of the database agent require
a service name be configured for the database server instance.

You may use iSQL to verify that you can connect to the service name. For example:
isgl -U <sa> -P <sa password> -S <name of server entry>

Mount the Local Manager CD on the server where the agent is to be installed. For
example:

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom
Change the directory to /cdrom/Unix (/cdrom/cdrom/Unix, if it is automounted):

Change the directory to the directory corresponding to the host’s Operating System.

# pwd
/cdrom/Unix/Solaris/8

Install the GSMbase, GSMImutil, GSMdb, and GSMsybase packages. If the GSMbase
and or GSMImutil packages are already installed, the installation will display an
informational message stating the package(s) are already installed.

# pkgadd -d . GSMbase GSMlmutil GSMdb GSMsybase

Enter a different installation location or press Enter to accept /app/storability. As
the screen displays, a symbolic link will be made to /opt/storability from the
installation path you specify.

Specify whether (y/n) to enable agent auto registration (default) or type n and
press Enter to disable agent auto registration.

Specify the IP address or network resolvable host hame of the Local Manager to be
contacted for agent auto registration or press Enter to specify the local host
(default).
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15.

16.

17.

18.

19.

20.

21,

22.

23.

24,

25,

21,

. Type the TCP Port Number the Local Manager uses for agent auto registration or
press Enter to specify the default port number (17146).

Read the information on how agents that do not require root privileges will be run
under a dedicated account. The default account is username “gsm” and group “gsm”.
The default Group ID is 1090.

Enter a group name to be used for ownership of gsm files or press Enter to use the
default group (gsm). If the group was not created already, specify whether (y/n) the
installation is to create it.

Type Group ID for the group or press Enter to accept the default GID (1090).

Specify whether (y/n) the Agent Monitor will restart the agent if it is detected as not
running.

Specify whether (y/n) to have the installation of GSMbase continue.

If continued, the installation will proceed and the GSMImutil package is next
processed.

The installation checks to determine if the username, gsm, exists. If not, specify
whether (y/n) to create the user.

Specify the User ID for the user or press Enter to accept the default User ID
(1090).

Specify whether (y/n) to continue with the installation of GSMImutil.

The GSMdb package is next processed.
Type y and press Enter to review/modify the Advanced Settings.

e Specify whether (y/n) the Agent Monitor will be used to restart the agent if it is
detected as not running.

e Specify whether agent auto registration is turned on (default) or off.

e Specify the IP address or network resolvable host nhame of the Local Manager to
contact for agent auto registration. The default value is local host.

e Specify the TCP port number the Local Manager uses for agent auto registration.
The default port number is 17146.

The GSMsybase package is next processed.
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Storability G3M 3vybase Agent

[gparc) prod-4.0,36-ga

Copyright (c) 2002 3torability, Inc

411 Fights Reserwved

This iz licenzed software. By installing this software you agree
to the terms of the licehse agreement included with the package in
JSopt/storability/GEHM-1license. txt

F3Msvbaze was built on Sunls 5.7.

Name of the Svybase database? [done] svbase

Uzername for agent access Lo database? [dbadmin]

Password for dbadmin: [password]
Confirm password:

IP address of database server? 192.168.0.55

TCP port of databaze zserver? [4100] [2]

Name of the Sybase database? [done]

Figure 32 - Install GSMsysbase

e Enter the name of the Sybase database and press Enter.
e Enter the Database user name and press Enter
e Enter the password for the above user and confirm the password.

Record the username and password information so that this information will be
available when you create the Database Agent’s account during the next step in
the procedure.

Username:

Password:

e Enter the IP address of the database server. Be aware the above screen is for
illustrative purposes only; the IP address line you use will be blank.

e Specify the TCP port number the database uses for client connections or press
Enter to accept the default port (4100).

e Repeat the above steps for each database. Press Enter on a blank “"Name of
the Sybase database?” line to indicate you are finished and continue.

e Specify whether (y/n) to restart the installed agents when installation is
finished.

e Specify whether (y/n) to continue the agent installation.

e If continued, the installation proceeds and returns you to the main package
installation menu.

e Select another Sun StorageTek Business Analytics agent package to install or
type Ctrl-D and q to exit.

CREATE DATABASE AGENT’S ACCOUNT ON SOLARIS - SYBASE

The Database Agent requires an account with SELECT permissions to specific tables. To
avoid using the system account, it is recommended that you create a dedicated account
with only the required permissions.
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The Storability Database Agent installation will install a set of utilities under the
directory:

/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the Sybase user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

3. Change user to the Sybase administrator account.

4. Read the /opt/storability/etc/dbAgent/Readme.db_perms.sybase file.

5. Run the /opt/storability/etc/dbAgent/create_user.sybase.sh shell script.

DATABASE AGENT FOR DB2 - SOLARIS

This section describes how you install, configure, and verify the Database Agent for DB2
on Solaris. The Database Agent requires the following four packages to be installed on
the Solaris server:

GSMbase
GSMImutil
GSMdb
GSMdb2

In addition to these packages, the Host Agent (GSMhost) agent package is typically
installed as well.

2. Mount the Local Manager CD on the server where the agent is to be installed. For
example:

# mount -o ro -F hsfs /dev/dsk/c0t6d0s0 /cdrom
3. Change the directory to /cdrom/Unix (/cdrom/cdrom/Unix, if it is automounted):

# cd /cdrom/Unix

4. Change the directory to the directory corresponding to the host’s Operating System.
For example:

# pwd

/cdrom/Unix/Solaris/8

5. Install the GSMbase, GSMImutil, GSMdb, and GSMoracle packages. If the GSMbase
and or GSMImutil packages are already installed, the installation will display an
informational message stating the package(s) are already installed.
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10.

11.

12.

hash-2.04# pkgadd -d . G3Mbase G3IMlmutil G3INdbh GSHMdbZ
Processing package instance <G3Mbaser from </mnt/Unix/Solaris/ 7=

Gtorability G3M base

[sparc) prod-4.0.3

Copyright (o) 2002 Storability, Inc
111 Fights Reserwved

This iz licensed software. By installing this software you agree
to the terms of the license agreewent included with the package in
Jopt/storability/ G3N-license.txt

G3Mbase was built on Sund3 5.7.

Flease enter the path where Global 3torage Manager should he
installed. If you enter a path other than fopt/storabhilitcy, a
gymbolic link will he created to Jfopt/storasbility from the real

install location.

Install path? [/app/storability] [?]

Figure 33 - Database Agent Package Installation for DB2

Enter a different installation location or press Enter to accept /app/storability. As the
screen displays, a symbolic link will be made to /opt/storability from the installation
path you specify.

Specify whether (y/n) to enable agent auto registration (default) or type n and press
Enter to disable agent auto registration.

Specify the IP address or network resolvable host name of the Local Manager to be
contacted for agent auto registration or press Enter to specify the local host
(default).

Type the TCP Port Number the Local Manager uses for agent auto registration or
press Enter to specify the default port number (17146).

Read the information on how agents that do not require root privileges will be run
under a dedicated account. The default account is username “gsm” and group “gsm”.
The default Group ID is 1090.

Enter a group name to be used for ownership of gsm files or press Enter to use the
default group (gsm). If the group was not created already, specify whether (y/n) the
installation is to create it.

Type the Group ID for the group or press Enter to accept the default GID (1090).

Inztall path? [fapp/storabilitcy] [ 2]

Enakble automatic agent registration? [v] [v.n,?]

Local Manager address for agent registration? [localhost]
TCP port for agent registration? [17146] [7]

Lgents which do not reguire root privileges will be run under a dedicated
account [(by default, username oS, group Jgst) .

That user account need not be set up yet, but the group ownership of all
the G3M files reguires that the group exist.

Group nawme for G3M files? [gsm]
Lutomatically create group? [n] [¥.n,?]

GID for gsm? [1090] [7]
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Figure 34 - Set Up GSMbase Component

13. Specify whether (y/n) the Agent Monitor will restart the agent if it is detected as not
running.

14.If the installation directory does not exist, specify whether (y/n) to have it created.

15. Specify whether (y/n) to have the installation of GSMbase continue.

16. The installation will proceed and the GSMImutil package is next processed.

17.The installation checks to determine if the username, gsm, exists. If not, specify
whether (y/n) to create the user.

18. Specify the User ID for the user or press Enter to accept the default User ID (1090).

19. Specify whether (y/n) to continue with the installation of GSMImutil.

Agents which do not recuire root privileges will be run under a dedicated
account [(default username JSm, Jroup JgsSml.

Uzsername for G3M £iles? [gem]

user 'gsw' does not yet exist

Automatically create account? [n] [¥.0,.?]
A 'gem' account, member of the group 'gsm' must be created before this

Figure 35 - GSMImutil Installation
20. Type y and press Enter to review/modify the Advanced Settings.

e Specify whether (y/n) the Agent Monitor will be used to restart the agent if it is
detected as not running.

e Specify whether agent auto registration is turned on (default) or off.

e Specify the IP address or network resolvable host name of the Local Manager to
contact for agent auto registration. The default value is local host.

e Specify the TCP port number the Local Manager uses for agent auto
registration. The default port number is 17146.

Processing package instance «<GHMdbh> from <£/cdrom/Thix/Solariss -
Jtorability 3M Database Agent

[sparc) prod-4.0.36-ga

Copyright (c) 2002 3torability, Inc

A1l Rights Reserved

This is licensed software. By installing this software you agree
to the terms of the license agreement included with the package in
Jopt/etorability /GEM-licensze. tdt

GEMdb was built on 3un0i 5.7.

The 'adwanced' settings all hawe reasonable default values, which most
likely need not be changed.

Modify adwanced settings? [n] [¥.n,?] ¥
Automatically restart this agent from agentMonitor: [v] [¥.n,?]

Enable automatic agent registration? [v¥] [¥.n,7]

Local Manager addresszs for agent registration? [localhost]

Figure 36 - GSMdb Installation
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21. Specify whether (y/n) to continue with the GSMdb installation.

TCP port for agent registration: [17146] [#]
Using </app/storability®> as the package base directory.
## Processing package information.
## Processing system information.
& package pathnames are already properly installed.
## Verifving package dependencies.
## Verifving disk space requirements.
## Checking for conflicts with packages already installed.
## Checking for setuid/setgid programs.

This package contains scripts which will be executed with super-user
permizsion during the process of installing this package.

Do you want to continue with the installation of <G3Mdb> [v,1n,7] I

Figure 37 - Completing GSMdb Installation

22. 1If the installation continues, the GSMdb2 package is next processed.

Processing package instance <GSMdbZ> from </wnt/Unix/Solaris/ 7>
Grorabhility G3M DEZ Agent

[sparc) prod-4.0.3

Copyright (o) 2002 3torability, Ine

111 Rights Reserwved

Thizs is liecensed software. By installing this software wyou agree
to the terwms of the license agreement included with the package in
Jopt/storabilicy/G3M-license.txt

G3MdbE was built on 3undd 5.7.

DEZ database instance hame?

Username for agent access to database? [dbZ2instl]

Password for dbZinstl? [adimin]

Confirm password?

Hosthamwme or IP address of database server?

TCP port of database serwver? [50000] [7?]

Figure 38 - GSMdb2 Configuration

23. For DB2 database instance name, enter the Node Name for connecting to the
database instance.

24. For username for agent access to database [db2inst1], enter the user name
the agent will use to connect or press Enter to accept the default user name
(db2inst1l).

For Password for [user name], type the password for the above database user
and then confirm that password. Record the username and password information
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25.

26.

27.
28.

29.

30.
31.

so that this information will be available when you create the Database Agent’s
account during the next step in the procedure.

Username:

Password:

For Hosthame or IP address of database server, type the network resolvable
host name or IP address of the database server.

For TCP port of database server, type the TCP Port number on which the
database server listens for connections or press Enter to accept the default TCP
port number of 5000.

Repeat the above procedure for each database server instance to be monitored.
At the DB2 database instance name? [done] prompt, press Enter to indicate
you have completed configuring DB2 instances and the installation continues.

DEZ database instahnce name? [done]
There are the DEZ elient libhraries (e.g. libdbZ2.sao)] installed? [?,q]l
[Re—)start agents after install [v] [v.h,?,d]

U=ing </app/storability> as the package hase directory.
## Processing package information.
## Processing system information.
S package pathhnsmes are already properly installed.
## Verifving package dependencies.
#f# Verifving disk space requirements.
f##f Checking for conflicts with packages already installed.

The following files are already installed on the systew and are heing
used by another package:

* fapp/etorability/ likh/ libdbZhelper. 30

* Japp/storabilicy/ lib/ libdbdry dba.so

* — ponflict with a file which does not helong to any packade.

Do wou want to install these conflicting files [v.n, ?,d]

## Checking for setuid/setgid programs.

Figure 39 - Completing GSMdb2 Installation

At the Where are the DB2 client libraries installed prompt, type the fully
qualified path to the DB2 client libraries. For example: /opt/IBMdb2/V7.1/1ib.
Specify whether (y/n) o restart the agents after the installation has completed.
The installation completes and returns you to the command line.
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Installing 3torability G3M DEZ bLgent as <G3MdbhE>

## Executing preinstall sScript.

Stopping Storsbility database agent: dbigent is not running.
## Installing part 1 of 1.
fapp/storability/ete/dblgent,/Readme . db perms. dbz
fappssatorabilitysete/dblgent/ocreate _user.dbz.sh
Japp/storability/likb/ libdbhZhelper.so
dappsstorabilitys lib/ libdbdry_dbz . so

Jete/init.dfdbZAgent <syrbolic links

[ werifying class <none> ]

Japp/storability/ete/agents: updated.

[ werifying class <cfg> ]
Japp/storability/ete/storability.inis updated.
[ werifying class <ini> ]

Japp/storability/gsm/ . cshre: updated.

Jappsatorabilicy/gsns . profile:  updated.

[ werifying class <prof> ]

## Emecuting postinstall sScript.

Storability agent startup:

Ftarting 3torabhility database agent: dbigent started
Storability agent startup complete.

Installation of <G3MdbZ> was successful.
hash-z.04#

Figure 40 - GSMdb2 Agent Installation Completed

CREATE DATABASE AGENT’S ACCOUNT ON SOLARIS — DB2

The Storability Database Agent requires an account with SELECT permissions to specific
tables. To avoid using the system account, it is recommended that you create a
dedicated account with only the required permissions.

The Storability Database Agent installation will install a set of utilities under the
directory:

/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the DB2 user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

3. Change user to the DB2 administrator account.

4. Verify the /opt/storability/etc/dbAgent/create_user.db2.sh script file has execute
permissions. If not, use the chmod command to add execute permissions.

5. Run /opt/storability/etc/dbAgent/create_user.db2.sh shell script.

Note: If the dbAgent is installed on Solaris for DB2, there is a manual configuration
setting that needs to be in place before the agent is started. If the you choose to run the
agent under gsm user, for example, the environment variable DB2INSTANCE in
/opt/storability/gsm/.profile, needs to be set to the active instance. For example:

DB2INSTANCE=<db2inst1>
export DB2INSTANCE
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If you choose not to run the agent under gsm user, the dbAgent script under
/etc/init.d must have the DB2INSTANCE variable set up. If the variable is not
configured, stop dbAgent and set it up as described above and then restart the
dbAgent again.

INSTALLING DATABASE AGENT ON IBM AIX

All currently supported AIX agents are provided as a “Tarball” with installation an script.
Dependencies between agents are not automatically detected, so they must be installed
in the correct order.

The dependencies for the existing agents are listed as follows:
e Host Agent - None

¢ SRM Agent - Host Agent

e Database Agent - Host Agent

To install an agent, simply ensure that the tarball (dbAgent-AIX.tgz) and the install
script dbAgent-install.sh) reside in the same location, and run the script.

AIX DATABASE AGENT CONFIGURATION

The Database Agent for AIX can be configured to support DB2 and/or Oracle database
instances.

1. Mount the installation CD in the CD-ROM drive of the AIX server. For example:

mount -v cdrfs -r /dev/cdO /mnt # /mnt directory must exist

2. Change directory to the software installation directory. For example:

cd /cdrom/Unix/AIX/5.2
3. Run the installation script:
./dbAgent-install.sh
4. When prompted, specify the database type is Oracle or DB2.

5. To configure the Database Agent for a DB2 database instance, the installer is
prompted to supply the following information:

e DB2 instance name

¢ User Name with which to connect; default name is “db2inst1”
e Password for above user; default password is “admin”

e IP address of the database server

e TCP port of database server; default port number is 50000

To configure the Database Agent for Oracle, the installer is prompted to supply the
following information:

e Database instance name

e User name and password with which to connect
e IP address and port of the database server

e The location of ORACLE_HOME if not detected

Agent Auto Registration

On an IBM AIX server, you must manually register the Database Agent to the Local
Manager after the software installation has competed. This is performed manually by
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either adding the entries for the GSM_LM_HOST in the storability.ini file for the agent or
by adding the SUB_AGENT entry in the Local Manager Routing Agent’s configuration
settings.

Sample agent storability.ini file (/opt/storability/etc/storability.ini) entries appear below.

GSM_LM HOST = 10.255.252.34
GSM_LM PORT = 17146
GSM_ENABLE LM REGISTRATION = true

CREATE DATABASE AGENT’S ACCOUNT ON AIX - DB2

The Database Agent requires an account with SELECT permissions to specific tables. To
avoid using the system account, it is recommended that you create a dedicated account
with only the required permissions.

The Database Agent installation will install a set of utilities under the directory:
/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the DB2 user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

3. Change user to the DB2 administrator account.

4. Read the /opt/storability/etc/dbAgent/Readme.db_perms.db2 file.

5. Run the /opt/storability/etc/dbAgent/create_user.db2.sh shell script.

CREATE DATABASE AGENT’S ACCOUNT ON AIX - ORACLE

The Database Agent requires an account with SELECT permissions to specific tables. To

avoid using the system account, it is recommended that you create a dedicated account

with only the required permissions.

The Database Agent installation will install a set of utilities and readme files under the
directory:

/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the Oracle user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

Change user to the oracle account.

Read the Readme.db_perms.oracle file located in /opt/storability/etc/dbAgent
directory.

5. Run the create user.oracle.sh script:

Hw

# su - oracle
# /opt/storability/etc/dbAgent/dbagent ora create user.sh <SERVER>
<DBAGENT USER> <DBAGENT PWD>

Where:

e SERVER = The service name for the Oracle Instance.
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e DBAGENT_USER = The username of the database account to create for the
Database Agent.

e« DBAGENT_PWD = The password for the database account being created.

At the “Enter Password:” prompt, enter the password for the sys account.

INSTALLING DATABASE AGENT ON HP-UX

The Database Agent supports Oracle and Sybase databases when installed on a HP-UX
server. Proceed as follows:

1. Mount the installation CD in the CD-ROM drive of the HP-UX server. For example:

# pfs mount -o xlat=unix /dev/rdsk/cXtXd0 /SD_CDROM
(where /dev/rdsk/cXtXd0 is the cdrom device)

2. Change directory to the software installation directory. For example:

cd /cdrom/Unix/HP-UX/11.0

3. Run the installation script:

./dbAgent-install.sh
4. When prompted, specify the database type is Oracle or Sybase.

5. To configure the Database Agent for Oracle, the installer is prompted to supply the
following information:

e Database instance name

e User name and password with which to connect
e IP address and port of the database server

e The location of ORACLE_HOME if not detected

To configure the Database Agent for Sybase, enter:
Name of the Sybase database
Database user name
Password for the above user and confirm the password
IP address of the database server

e TCP port number the database uses for client
Agent Auto Registration
On an HP-UX server, you must manually register the Database Agent to the Local
Manager after the software installation has competed. This is performed manually by
either adding the entries for the GSM_LM_HOST in the storability.ini file for the agent or
by adding the SUB_AGENT entry in the Local Manager Routing Agent’s configuration
settings.

Sample agent storability.ini file (/opt/storability/etc/storability.ini) entries appear below.

GSM LM HOST = 10.255.252.34
GSM_LM PORT = 17146
GSM_ENABLE LM REGISTRATION = true

Page 57 Database Agent Installation Guide



CREATE DATABASE AGENT’S ACCOUNT ON HP-UX - ORACLE

The Database Agent requires an account with SELECT permissions to specific tables. To
avoid using the system account, it is recommended that you create a dedicated account
with only the required permissions.

The Storability Database Agent installation will install a set of utilities and readme files
under the directory:

/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the Oracle user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

3. Change user to the oracle account.

4. Read the Readme.db_perms.oracle file located in /opt/storability/etc/dbAgent
directory.

5. Run the create user.oracle.sh script:

# su - oracle
# /opt/storability/etc/dbAgent/dbagent ora create user.sh <SERVER>
<DBAGENT USER> <DBAGENT_ PWD>

Where:

e SERVER - The service name for the Oracle Instance.
e DBAGENT_USER - The username of the database account to create for the
GSM database agent.

e DBAGENT_PWD - The password for the database account being created.

At the “Enter Password:” prompt, enter the password for the sys account.
CREATE DATABASE AGENT’S ACCOUNT ON HP-UX - SYBASE
The Database Agent requires an account with SELECT permissions to specific tables. To

avoid using the system account, it is recommended that you create a dedicated account
with only the required permissions.

The Database Agent installation will install a set of utilities under the directory:
/opt/storability/etc/dbAgent
To use the utilities, proceed as follows:

1. Log in as root.

2. Verify that the Sybase user has write access to /opt/storability/etc/dbAgent. This is
required because the script will create a log file under this directory.

3. Change user to the Sybase administrator account.

4. Read the /opt/storability/etc/dbAgent/Readme.db_perms.sybase file.

5. Run the /opt/storability/etc/dbAgent/create_user.sybase.sh shell script.

VERIFYING DATABASE AGENT FUNCTIONALITY

Use the Agent Diagnostic Tool (GSMDiag) to verify the Database Agent functionality.
GSMdiag is installed as part of the Sun StorageTek Business Analytics Central Manager
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or Local Manager software installation. It represents the primary tool to verify agent
functionality or troubleshoot agent problems.

Proceed as follows:

1. Wait approximately 30 seconds after the Database Agent has started to allow it to
initialize before querying it with GSMdiag.

a. In the Agent location window, enter the IP Address or network resolvable Host
Name of the server where the agent is installed in the ip address/host name
input box.

b. Set the port to 17148 (or select the Database agent from the drop down list of
service names).

c. Click the Get Object List button and you should receive a list of objects
published by the Database Agent.

d. Select the gsa_dba_served_databases-2_1 object and it should report the
monitored database servers, including database server IP address, TCP port
number, database type (e.g., db2), version, instance name, and timestamp.

Ejgsa_dha_served_databases—z_l - Storability Software G5™ Agent Diagnostic Tool
| File Edit Wiew Actions Help

IR

Agent Infa | Specific Targetl Lser Parametersl Console
GEM network "soft fetch" request to agent at ;I
Agent location————— — System Parameters 192 168.1.141:17148 for object

. . "g=za_dba_serwved database=-Z2 1" =succeeded.
ip address/host name timeout [zeconds] 6 colunnis) found.

|182_‘IES_‘I_14‘I |3E| 11 rowis) retrieved.
request completed in 1 second(s).

tcp part/service name

[ hard fetch
[1714 [

Publizhed Objgcts

Igsa_dba_sewed_databases-2_1 j EI LI

db_server_ip | instance_name | port_no | db_name | awner | timeskarnp

192.168.1.141  INSTRUCTORIWZE 1433 AdventuretWorks2000  INSTRUCTORIWZ2K)instructor. 3 Wed Jun 01 13:29:05 2005
192,165.1.141  INSTRUCTORIWZE 1433 assurent 53 wied Jun 01 13:29:08 2005
192,165.1.141 IMNSTRUCTORIWZK 1433 master -] wed Jun 01 13:29:08 2005
192.165.1.141 INSTRUCTORIWZEK 1433 rode! 53 whed Jun 01 13:29:08 2005
192,1658.1.141  IMSTRUCTORIWZK 1433 msdb 53 wed Jun 01 13:29:08 2005
192.168.1.141 INSTRUCTORIWZE 1433 Marthwind 58 Wed Jun 01 13:29:08 2005
192,165.1.141  INSTRUCTORIWZE 1433 porkal 53 wied Jun 01 13:29:08 2005
192.168.1.141  INSTRUCTORIWZE 1433 pubs 58 Wed Jun 01 13:29:08 2005
192,165.1.141  INSTRUCTORIWZE 1433 RepartServer IMATRUCTORSW 2K instruckor, 3 w'ed Jun 01 13:29:08 2005
192.168.1.141  INSTRUCTORIWZE 1433 RepartServerTempDE  INSTRUCTORIWZ2K)nstructor. 3 Wed Jun 01 13:29:05 2005
192,165.1.141  INSTRUCTORIWZE 1433 tempdb 53 whed Jun 01 13:29:08 2005

Figure 41 - gsa_dba_served_databases-2_1

e. Proceed to collect all other objects published by the agent.

2. To verify the Database Agent has registered successfully with its configured Local
Manager:

a. In the Agent Info window, enter the IP Address or network resolvable Host
Name of the Local Manager in the ip address/host nhame input box.
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b. Set the port to 17146 (or select the Routing Agent from the drop down list of
service names).

c. Click the Get Object List button and you should receive a list of objects
published by the Routing Agent.

d. Select the gsa_agent_register table.

e. Verify this collected object reports the Database Agent in the “active_peer” field
by IP address and port number of 17148.

VERIFYING MANAGEMENT CONSOLE FUNCTIONALITY

The following procedure describes how the Sun StorageTek Business Analytics
administrator verifies the Database Agent’s reports in the Management Console. Refer to
the Administration chapter to obtain information on the administrative menus you can
access from the Tools pull down menu, including the Data Polling Schedule and
Change Dashboard menus.

1. Log in to the Management Console as an administrative user (e.g., gsmuser) whose
views provide access to the desired assets (e.g., sites).

2. Verify that your customized Home Page includes the Database Management

dashboard (or use Change Dashboard to assign one).

Select Tools->Data Polling Schedule.

Use the Collect Now button to collect the Database (collection type) Configuration

(Collection Metric) data using a polling schedule that includes the specific site or all

sites.

5. Use the Collect Now button to collect the Database (collection type) Performance
(Collection Metric) data using a polling schedule that includes the specific site or all
sites.

6. Close the Data Polling Schedule window.

7. Verify the Database Management dashboard reports information on the database
servers monitored by the Database Agent you are verifying.

8. Click Databases->Database Configuration/Capacity. The Change Parameters
dialog appears.

9. Set the desired start date and end dates and click Generate Report.

10.In the Database Configuration/Capacity window, expand the appropriate site.

11. Select a database server monitored at the site and the Database Server Detail report
is displayed.

12. Repeat Step 11 for each monitored database server.

13. Close the browser session with the Management Console as the above steps
complete verifying the Management Console functionality.

Hw

DATABASE AGENT TROUBLESHOOTING

1. Verify system/agent prerequisites - Refer to Sun StorageTek Business Analytics
Support Matrix that is located on the Documentation CD to verify the most recent
support requirements for the agent.

2. Verify the Database Agent has sufficient database access permissions by examining
its Message Log.

3. Use GSMdiag to save the output for all the tables if escalating a problem to a
Support representative.

a. Run GSMdiag.
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b. Enter the IP Address or Hosthname of the server where the agent is installed
and set the port to 17148 (or select the Database agent from the drop down list
of service names).

c. Click the Get Object List button and you should receive a list of tables published
by the Database Agent. If unsuccessful, verify the Ethernet connectivity to the
server running the Database Agent and that the Database Agent is running.

d. Select the alerts-3_1 table and examine the Description column for each
reported alert.

e. Select File->Save All and the “This action will network fetch all objects
published by the currently specified agent and save the data to a single file.”
Message appears.

f. Click OK and the Save As dialog appears.

g. Enter a meaningful file name and click OK to initiate the collection.

h. Enter the desired file name and click OK.

4. Review the Message Log - Review/collect the agent’s Message. log file that can
contain information on startup errors, configuration errors, or errors regarding
accessing data or parsing output.

Refer also to the Verifying the Database Agent Access Permissions section for your
installed SQL dialect (e.g., Sybase) to review common messages related to database
access permissions.

Windows

e Located by default in: <drive>:\Program Files\Storability\GSM\Agents\Storability
Database Agent folder.

e Can enable debug level logging by appending LOG_SEVERITY=Debug to the
Database Agent section of the storability.ini file (if Customer Support requests it).

Solaris

¢ The agents common Message.log file located by default in: /opt/storability/data.

e Can enable debug level logging by appending LOG_SEVERITY=Debug to the
Database Agent section of the storability.ini file (if a Support representative
requests it).

5. Verify Local Manager Registration - The configured Routing Agent’s
gsa_agent_register table should be reviewed if the auto-registration feature is
enabled (default). Otherwise, verify the necessary sub agent entry has been added
to the Routing Agent’s storability.ini file.

6. Review the Routing Agent Message Log - Review/collect the Routing Agent
Message Log to check for errors related to Ethernet connectivity problems contacting
the Storability Database Agent and registration information.

7. Confirm Data Polling Schedules - Using the Management Console’s Data Polling
Schedule menu, review/modify the existing Polling Schedules for the Collection Type
of Database for all sites.

8. Review Aggregator Message Log - Open the Aggregator’s Message Log in a text
editor and validate that the Database Tables are being requested and rows are being
inserted into the database.

The log contains two entries, TID (Transaction ID) and SID (Session ID), which can
help you locate (e.g., Find) and view relevant logged entries. For scheduled polling
requests, the TID will be equal to the Job ID in the Polling menu. Each SID is a
unique identifier for a particular agent data collection session. For on-demand polling
requests, the TID is a uniquely generated TID (not the Job ID) and SID, and the TID
and SID will be equal to the same integer value.
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9. Check the assurent database - The assurent database is the data repository for
your Sun StorageTek Business Analytics application. For the Database Agent, use
any MS SQL Query interface, such as isql, to verify rows have been inserted into the
database-related tables, such as the gsa_dba_database_server table.

v b N ”Ei azsurent j EE@EJJ

select ¥ from gsa dba database serwver =
-
l | o]
acom_id|db serwver ip port no |datsbase type VEeErsion
1 302 192 .165.1.132 1433 sqlserver §.00.780
E 30z 192.1685.1.136 14353 sglserver §.00,.760

Figure 42 - Verify Rows in gsa_dba_database_server Table

10. Verify Management Console - To complete the troubleshooting procedure,
minimally verify the monitored database servers are reported in the Database

Management pane on the Management Console’s Home Page.

Server Name Database Used (MB)

Used B 0.47 "y
Fros GEL .03 INSTRUCTORIWZE  ReportSaryerTempDB 0.90
Total GB: 0.20 INSTRUCTORIWZE  tempdb 1.01
Databascs: 18 INSTRIGCTORIWZE  modsl 1.13
INSTRUCTORIWZK  pubs 2.08
W 5o Uees INSTRUCTORIWZE  ReportSaryer z.1l
117 Free INSTRUCTORSWEE  Northesind 3.52
TMSTRUCTORIWZE  madb 11,78

Total {ME)
1.24
£.50
1.25
2.50
2.50
4.25

14.00

%0 Space Used
72.33
I1.86
Q0,00
g2.50
64.33
g2.90
a4.15

G

Figure 43 - Database Management Pane

UPGRADE DATABASE AGENT

For upgrading a Database Agent, uninstall the previous release of the Database Agent
before you upgrade by installing the Database Agent for the current release of the Sun

StorageTek Business Analytics software.

UNINSTALL DATABASE AGENT — INSTALLSHIELD

1. Select Start->Program Files->Storability->Uninstall->Uninstall Local

Manager
Or:

Start->Program Files->Storability->Uninstall->Uninstall <Database Agent

Name>. The Storability Uninstall dialog appears.
Click the checkbox for the appropriate Database Agent.
Click Next>. The Question dialog appears.

PN

as each selected agent is uninstalled.

5. When the InstallShield Wizard Complete dialog box appears, click Finish.

Database Agent Installation Guide

Click Yes to confirm uninstalling the agent. An uninstalling agent splash box appears

Page 62




UNINSTALL DATABASE AGENT — SOLARIS

To uninstall the Database Agent on Solaris, you uninstall the GSMsysbase or GSMoracle
package and then uninstall the GSMdb package.

1.

4.

Type:

pkgrm GSM<DB_Agent Name>
At the “do you want to remove this package” prompt, enter y and press Enter.
At the “do you want to continue the removal of the package?” prompt, type y and
press Enter. The "Removal of GSM<DB_Agent_Name>" agent was successful”

message appears.

Repeat the above procedure to uninstall the GSMdb package.

REINSTALL AGENT — NON-SOLARIS UNIX HosT

The reinstallation procedure for all Storability agents supported on non-Solaris UNIX
hosts, such as the Database Agent on an HP-UX server, requires that the installer
perform the following steps before running the agent’s installation script:

1.

2.

6.

7.

Make a backup copy of the existing agent configuration file (storability.ini).
Make a backup copy of the contents of /opt/storability/etc/agents.

Open the existing agent configuration file (storability.ini) in a system text editor.
Locate the configuration section for the agent to be reinstalled.

Delete all existing configuration settings for that Storability agent.

Save the modified agent configuration file.

Remove the existing /opt/storability/etc/agents directory.

At this point, you may reinstall the agent using the agent’s installation script (e.g.,
dbAgent-install.sh).
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APPENDIX A: DATABASE AGENT AND DB2

Sun StorageTek Business A

nalytics reports, such as the Database Management pane,

can currently show one hundred percent (100%) storage utilization for some DB2
databases. The user is given the impression that the DB2 database is running out of

space where, in fact, this is

As this section will describe

not necessarily true.

, this is not a correct storage utilization percentage if the DB2

database is wholly comprised of System-Managed Storage (SMS) tablespaces. Table 1

provides definitions for the

As subsequently explained,
utilization at the container |

two types of DB2 tablespaces.

the Database Agent does not correctly report storage
evel because of a restriction in the DB2 Call Level Interface

(CLI), which the Database Agent (dbAgent) uses to query the DB2 database tablespace’s
total space and used space.

DB2 STORAGE MODEL

The following table describes the DB2 storage model.

DB2 Storage Element

Description

Tablespaces

Tablespaces in DB2 provides a logical layer between data and
the storage devices. They define where table data is
physically stored on disk. DB2 UDB (Universal Database)
supports two types of tablespaces: System-managed storage
(SMS) tablespaces and Database-managed storage (DMS)
tablespaces.

SMS Tablespaces

e Storage is allocated by Operating System as needed.

e A SMS tablespace can only use directory container. It
cannot use files or raw container (character device).

e Size will increase to the limits of the device on which the
container (directory) is defined.

Because of the above characteristics of SMS tablespaces, the
Database Agent reports the used space and the total space
as being equal.

DMA Tablespaces

e Tablespaces are built on pre-allocated portions of
storage, which are known as “containers”

e The “containers” can be either files or raw devices and
the DB2 Database Manager manages their storage.

Because of the above characteristics of DMS tablespaces, the
Database Agent (dbAgent) can report on used space and
total space allocated and thus storage utilization can be
correctly calculated and reported.
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DB2 Storage Element

Description

Containers

e A container is a directory, a regular file, or a raw device.

e DB2’'s Call Level Interface API does not provide an
interface to used storage (i.e., used page).

e Page has size of 4K, 8K, 16K, and 32K at the container
level.

Because of the above characteristics of DB2 containers, the
Database Agent is limited in reporting container’s used
space. Currently dbAgent report used space as total space
for container.

Extent

e An extent is defined as a number of pages (default to 32
pages) within the container.

e Currently, the Database Agent does not report on
extents.

Table 7 - DB2 Storage Model

DATABASE AGENT’S REPORTING ON DB2 STORAGE UTILIZATION

When the Database Agent uses the DB2 CLI interface to query the tablespace’s total
space and used space, the DB2 Application Programming Interface (API) call returns a
data structure in which the “usedPages” field is only applicable to Database-managed
Storage (DMS) tablespaces. For SMS tablespaces, the “usedPages” field is the same as
that for “totalPages.” This limitation of the DB2 API results in the percentage (%) space
utilized that the Database Agent reports to be inaccurate for SMS tablespaces.

Figure 2 shows how the

Database Agent’s gsa_dba_logical_storage_unit-2_2 object

reports the used space as the same as the total space for SMS tablespaces through the
use of the Agent Diagnostic Tool (gsmdiag.exe).

Ejgsa_dha_logicaI_storage_unil:—Z_Z - Storability Software GSM Agent Diagnostic Tool
File Edit WYiew Help

IR

Agent Info | Specific Targetl User Parametersl

Caonzole

G5 network "soft fetch" regquest to agent at cust3-hal:17148 for object

Agent location

ip addresz/host name

System Parameters—

timeout [secondsz|

Icust3-ha1

tcp port/service name

f30

[~ hardfetch

Publizhed Objects

I gsa_dba_logical_stolage_unit-2_j Get Object List I

"g=za_dba_logical_storage unit-2_2" succeeded.
9 colunni{=) found.

9 rowvi=) retrieved.

request completed in 1 second(=).

db_server_ip | instance_name

| port_no | db_niame

| unit_type | unit_narne | used_space | total_space | timestamp

DEZSOLS
DEZALY7
DEZALY7

10.255.252.90

10.255.253.37 DB250LE S0o002 SAMSCL sms SYSCATSPACE 19336 19336 ‘Wed Jan 05 11:14:31 2005
10.255.253.37 DB250LE S0o002 SAMSCL sms TEMPSPACEL 4 4 ‘Wed Jan 05 11:14:31 2005
10,255.253,37 DBE230LE S0002 SAM3A0L SMs USERSPACEL 1626 1625 ‘Wed Jan 09 11:14:31 2005
10,255,253, 37 50002 SAMSCL database SAMSOL 20965 20965

50000 SAMALR

wed Jan 05 11:14:31 2005
Wed Jan 05 11:14 05
wed Jan 05 11:14:31 2005

SYSCATSPACE

sms TEMPSPACEL 4 4

10,255,252,90 DB2ALLT s0000 SAMATY sms USERSPACEL 1344 1344 Wed Jan 05 11:14:31 2005
10,255,252,90 DB2ALLT s0000 SAMATY dms TOMS_TESPO 640 40000 Wed Jan 05 11:14:31 2005
10,255,252,90 DB2ALLT s0000 SAMATY database SAMATLS 10876 50236 Wed Jan 05 11:14:31 2005
Figure 44 - Agent Diagnostic Tool
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The used page and total page reporting issue for SMS tablespaces can also be
demonstrated by issuing the list tablespaces show detail command as shown below.

db2 => list tablespaces show detail

Tablespaces for Current Database

Tablespace ID =0

Name = SYSCATSPACE
Type = System managed space
Contents = Any data

State = 0x0000

Detailed explanation:
Normal

Total pages = 4834

Useable pages = 4834

Used pages = 4834

Free pages = Not applicable
High water mark (pages) = Not applicable
Page size (bytes) = 4096

Extent size (pages) = 32

Prefetch size (pages) = 32

Number of containers =1
Tablespace ID =3

Name = DMS_TBSPO

Type = Database managed space
Contents = Any data

State = 0x0000

Detailed explanation:
Normal

Total pages = 5000

Useable pages = 4960

Used pages = 96

Free pages = 4864

High water mark (pages) = 96

Page size (bytes) = 4096

Extent size (pages) = 32

Prefetch size (pages) = 32

Number of containers =1
CONCLUSION

This appendix has illustrated the restriction in the DB2 CLI/API interface, which the
Database Agent uses to report on DB2 databases, that can cause incorrect reporting on
storage utilization for certain types of DB2 storage.
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